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Website Builder 6 Help Guide 
 

Website Builder 6 is a legacy product and is no longer sold. This guide contains archived Help 
content for Website Builder 6 to help answer questions. However, it’s no longer being updated 
as of March 2020. 
 
To find answers in this guide: 
 

• Select any title in the Contents to go directly to a specific Help article.  
• Use the Find function (Ctrl + F for Windows OR Command + F for Mac) in your browser 

to search the whole PDF for specific keywords. 
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About the Home Page 
 

The Website Builder home page gives you at-a-glance information about your site. From here, 
you can click to add new pages, work with existing pages, upload new files and images, and 
manage other aspects of your site. 

Website Builder consists of two main areas, the home page and the Page Designer. The home 
page helps you complete administrative tasks, like adding a forum or a guestbook, while you 
use the Page Designer to design the individual pages of your site. 

Note: For a more detailed explanation about the features you can add from the home page, 
including links to how-to help, see Menu Bar Options below. 

 

To Design Your Site 
 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. From the Website Builder home page, in the Getting Started area, click Design Your 
Pages.  

 

Menu Bar Options 
 

The menu bar displays along the top portion of the screen and provides access to over 20 
different features. 

 

Home — Returns to the Home page. 

Design 

Launch Page Designer — Displays the Page Designer where you can design and 
modify your Web pages.  

Template and Colors — Goes to the Template tab where you can select from a 
variety of templates and change their color schemes. 
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Advanced Style Options — Displays the CSS editor where you can make changes 
to your site's CSS. 

Advanced Color Options — Displays a page where you can individually modify 
the colors your site is using. 

Add-Ons 

Guestbook — Guestbooks let your site visitors sign their name on your site to 
indicate their visit.  

Flash® Intro — A Flash Intro displays before users see your site's home page.  

Forum — A forum is an area of your site that allows users to create and comment 
on ongoing discussions.  

Coming Soon Page — Coming soon pages alert visitors that you intend to have 
your site ready soon.  

Quick Shopping Cart® — Set up a link to your Quick Shopping Cart site.  

Manage 

Organize Site — Add, delete, rename, and make other changes to pages your 
site uses.  

Google Sitemaps — Sitemaps can help make your site more searchable.  

Backup/Restore — You can backup your site and restore it at any time.  

Publish — Goes to the Publish page where you can publish your website.  

Publish Selected Pages — Allows you to specify pages you want to publish.  

Publish History — Shows the date, time, duration, state, any messages, and log 
files of all previous publishes. 

File Size/Loading Info — Website Builder helps you determine your site's 
performance and address any areas for improvement.  

Password Protection — You can password protect your site to prevent unwanted 
access.  

Upload Files and Images — You can upload and manage files and images in 
Website Builder.  

Spell Check — Website Builder can check your spelling on all your pages or only 
pages you specify.  
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Fonts — You can download additional fonts to display as captions on your 
images.  

Restart Site — Start over from scratch by using Website Builder's Restart Site 
function.  

Settings 

Site — Modify the settings created when you first set up your Website Builder 
account. 

Configuration — On the Configuration page you can specify details such as 
whether to show the Website Builder banner, search engine information, spell 
check and other options. 

Help 

Help — Displays the Help Center. 

Support — Goes to our support page where you can submit a support ticket. 

Read our Blog — Displays the developer's blog where new features are 
announced. 

 

 

Importing Content from Previous Projects or Backup Files 
 

With Website Builder, you can import content from a block into another block. The blocks don't 
have to belong on the same page. To import content you must make, or have made, a backup 
of your website. For information about backing up your website, see Backing Up or Restoring 
Your Website. 

To Import Content from a Previous Project or Backup File 

1. Log in to your Website Builder account. 

2. Click Design Your Pages. 

3. If necessary, from the Page menu, select the page you want to modify. 

4. Go to the content block where you want to import content, hover your mouse over 
the gear icon, and then click Import Backup. 
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5. Select the content you want to import from the following fields: 

Select the Backup 

The version of your website that contains the content you want to import. 

Select the Page 

The page that contains the content you want to import. 

Select the Block 

The block that contains the content you want to insert. 

 Note: You can preview the imported content in the Content Preview window. 

6. Click OK. 

 

 

Backing Up or Restoring Your Website 
 

Website Builder allows you to manually create up to five backup copies of your website, and if 
necessary, restore your website from a backup version. Before you can restore a previous 
version of your website, you must have created a backup copy. The restore options do not 
display if you haven't created a backup copy. For more information, see Importing Content 
from Previous Projects or Backup Files. 

Note: A backup of the site is automatically created whenever you publish your 
site, restore it, select a new theme or restart your device. A maximum of five 
backups are created. The oldest of the five versions is deleted whenever a new 
backup is created. There's no time limit on using the backups. 

 

To Back Up Your website 
 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. From the Manage menu, select Backup/Restore. The Backup and Restore page displays. 
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4. In the Enter a name for this copy field, specify the name for the backup file. 

5. Click Save website. 

 

To Restore a Backup Copy of Your website 
 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. From the Manage menu, select Backup/Restore. 

4. In the Restore a Previous Project area, click the Restore button for the project you want 
to restore. The Restore button is located in the Restore column of the list. 

5. To make a backup copy of your current website before restoring the saved copy, 
click OK. Website Builder restores the saved copy of your project. 

 

 

Getting Started 
 

Website Builder lets you quickly create dynamic websites without experience in coding or Web 
design. It's as simple as dragging and dropping. 

1. Log in to your account. 

2. Click Website Builder. 

3. Next to the Website Builder account you want to use, click Manage. 

4. From the Welcome to Website Builder window, select the domain name for your 
website. 

5. Select that you have read and agree to the terms and conditions of the Website Builder 
Service Agreement, and then click OK. 
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6. Select one of the following setup options, and then complete its steps: 

o Get Your Website Online Fast — It's the fastest setup option. Your website content 
is pre-filled, including images, page titles and navigation buttons. Just tell us about 
your site, pick a template, and then select your pages. You can always replace text 
and images later. 

o Make Your Website Perfect — It's the most popular setup option. Simply select a 
template, and then start working on your website. You can add your own images, 
text, videos, and more using our drag-and-drop Page Designer. 

Note: If you want to build your website from scratch and still get the convenience of a drag-
and-drop Page Designer, select I'm pretty advanced. Let me start editing HTML/CSS. 

 

 

Designing Pages 
 

Designing your pages with Website Builder v6 is easy using the Page Designer. You can use a 
drag-and-drop interface to select and add design elements. You can also add various page 
types and features, and change the style of your template. We even have you covered for a 
mobile version of your website. 

1. Log in to your account. 

2. Click Website Builder. 

3. Next to the account you want to use, click Manage. 

4. Click Design Your Pages. 

5. Click either Popular, Media, Social, Apps, or Tables & Forms, and then drag and drop 
the icon for each design element you want to add over a Drop Zone. Drop Zones display 
on your Web pages when you hover over them. 

6. Click Pages, and then select the page types or features you want to add. 

7. Click Styles, and then select the style aspects you want to change for your template. 

8. Click Mobile, and then view your free mobile website — if you have a Deluxe or Premium 
account. 
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Adding and Editing Content Using the Page Designer 
 

From the Page Designer page, you can add, edit, and format your website content. For 
example, you can change the font colors, make your text bold or underlined, and align text to 
your specifications using the text formatting tools located at the top left corner of the page. 

The Page Designer page includes a tab-based toolbar that allows you to add and edit 
specialized content. The three tabs found on the tool contain the following: 

Page 

Add a page, change your layout, edit navigation or template images or preview your 
page as it displays in a Web browser. 

Insert 

Select from a large assortment of objects to insert into your Web page. Easily insert 
objects such as video, Flash®, music, RSS feed, JavaScript, table, or a contact form. 

Options 

When you open a content block the Options tab displays. You can delete the block, 
share the block with another Page, clear the contents of the block, or move the block to 
another location on the page. 

To add content to a Web page, you will need to add the content to a content block. Content 
blocks are outlined in blue. 

1. Log in to your Website Builder account. 

2. From the Design menu, click Page Designer. 

3. If necessary, from the Page list, select the page you want to edit. 

4. Click the block you want to add content to. 

5. Position your cursor where you want to add your content. 

6. You can begin entering text or use the toolbar at the top of the page to add content. 

Note: From the Edit Content window, you can design your pages using What You See Is 
What You Get (WYSIWYG), where you can view the changes as you make them, or you can 
click HTML to design your site using HTML tags to format your content. To return to 
WYSIWYG click Design. 
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About the Publish Details Page 
 

When you publish your site, you are brought to the Publish Details page. In Website Builder, the 
Publish Details page confirms that your site has been successfully published. You can view 
specific publishing details by selecting the following: 

View Publish Log 

Lists the actions that were performed during the most recent publishing. To view the 
logs of previous publishing operations, click View Publish History, then select Log next 
to the date you want to view. 

View Publish History 

Lists details of previous publishing sessions. 

You can view your website, in its newly published form, by clicking your domain name in the 
Publish Details area. 

 

 

What Are My Text Layout Options? 
 

Website Builder offers you many layouts to choose from. Each layout includes specific areas for 
your title text, your subtitle text, and your main content. For best results, your Web page 
content should be added to content blocks in the body of your Web page. With the exception of 
your page title, content should not be entered into the heading at the top of your page. 

When adding text to your website, you may want to consider the following guidelines: 

Page Title 

The page title should summarize the contents of the page. This should be no more than 
one sentence in length. Just a few words may suffice. A lengthy title may disrupt the 
layout of your page. 

Content Headings 

Adding a heading to each unique block of text is useful for highlighting individual 
sections. Headings do not need to be gigantic. Typically, one and a half times the size of 
body text is recommended. You also have other options that allow you to emphasize 
headings without increasing their size. For example, you can make the text bold or use a 
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different color. These techniques can be especially helpful when you need multiple levels 
of headings. 

Column Width 

In Website Builder, content blocks are designed with a pre-determined width. This 
ensures good readability as the reader does not have to scan a wide body of text. 

Font Size 

The size of text should also be considered for your target audience. If the text is too 
small or too large, the reader may lose track of the start of each line. 

Text Alignment 

There are several ways to align text: 

o Left aligned text has a straight left margin, but a ragged right margin as 
different lines take up different amounts of space. 

o Right aligned text is the reverse, lined up along the right margin instead. 
o Center alignment places items an equal distance from the left and right 

margins. 
o Justified text alters word and letter spacing so that it lines up along both 

margins. 

 
 

Add a Pre-Built Page 
 

With the Pre-Built page feature in Website Builder, you can easily select from a list a specially 
designed pages and choose the one that best suits you needs. Pre-built pages include page 
layout elements and real content, designed to guide you through building the website you want. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page list, select the page you want to edit. 

5. Go to the Pages tab, and then select Add Pages. 

6. from the Page Type menu, select Pre-Built Page. 
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7. From the Category menu, select the type of Site you are building. 

Note: If you don't find the type of site you are building in the Site Type list, you can 
select a type that might work for you. For example, a small business site type might 
work for a family reunion site. You can preview the layout of your selected site type in 
the Page Layout area. 

8. From the Page list, select what type of page you want to add, click Add Page. 

9. In the Page Title field, enter a title for your page. 

10. To allow Website Builder to automatically include the page in your navigation, 
select Include in Site navigation. 

Note: This will overwrite any settings or subnavigation you may have added from the 
Edit Navigation page. 

11. Click OK. 

 Note: You can change the content of any page you add, at any time. 

 

 

Setting Page Properties 
 

You can increase the visibility of your website by using Meta tags, a sitemap, and JavaScript 
from third-parties such as Google® in Website Builder. Search engines use this information 
when ranking websites in search results. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. Click Pages, and then select Page Properties. 

5. If necessary, from the Pages menu, select the page where you want to edit page 
properties. 

6. From the Page tab, edit the the titles you want: Browser Title, Heading Title, Button 
Title, and Filename. 
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7. From the Meta Data tab, edit any of the following information: 

o Description — Enter a detailed overview of your website. The description displays 
with your website's title and URL in search engine listings. For example, you could 
include topics covered in the content, your website's name, company name, or tag 
line. 

o Keywords — Enter keywords for your website. You could include words or phrases 
that Internet users might use to search for your site. You could also include the topic 
of your website or specific pages, your website name, company name, or other 
related terms. Keywords must be separated by commas. 

o Add Meta Tag — Enter the name of the tag and content, and then click Apply. 

8. To help Google determine how often to check your site, go to the Sitemap tab, and then 
edit any of the following: 

o Change Frequency — Select how often you update Web pages. It tells search 
engines when they should crawl your site for updates. 

o Priority — Select a priority level for the page. It tells search engines the important of 
pages compared with the rest of your site. Changing priority does not affect how 
often search engines crawl a page. It can be a number between 0.1 and 1.0, with 0.1 
being the lowest and 1.0 being the highest. Your most important page should be a 
1.0. 

o Exclude from Sitemap — From the Pages menu, select an individual page to exclude 
search engines from crawling, and then select this option. 

9. To enter JavaScript in page headers or bodies, go to the JavaScript tab, and then enter 
the script. 

10. Click OK. 
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Adding Heading Tags 
 

If you are receiving the error "The majority of your pages have heading tag issues" in Search 
Engine Visibility V1, you may need to edit some of your HTML in Website Builder v6. Adding 
heading tags helps search engines crawl your site and may improve your rankings. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. From the Design menu, click Page Designer. 

4. If necessary, from the Page list, select the page that contains the block you want to edit. 

5. Move your mouse to the block you want to edit and click. The block displays the Edit 
Content window. 

6. Select the text you want to edit and select the heading from the drop down in the 
toolbar. 

7. Click the Save icon. 

 

 

Publishing pages 
 

It only takes a few clicks in Website Builder v6 to publish your website and to have it appear on 
the web. Before you publish, however, you'll want to preview how the website will look online. 

 

To preview your website 
 

1. Log in to your account and open Website Builder v6.  

2. Next to the account you want to use, click Manage. 

3. Click Preview. 

4. In the preview window, review your website's content. 
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5. To make changes, go to the Website Builder home page, and then click Design Your 
Pages. For more information, see Designing Pages. 

 

To publish your website 
 

1. Log in to your account and open Website Builder v6. 

2. Next to the account you want to use, click Manage. 

3. Click Publish Site. 

4. To create a backup of your website, select Back up website prior to publishing. 

5. To publish your entire website, click Publish All. If it's your first time publishing, this is 
your only option. 

6. To publish only the pages you updated, click Publish Updates. 

 

 

Adding, Deleting, and Organizing Pages 
 

With Website Builder version 6, you can add and publish as many Web pages as your account 
allows. You can also delete pages you no longer want. To better organize your site, you can 
arrange the order in which your pages display and choose not to publish specific pages. 

Note: If your account uses a .mobi domain name, you can only add mobile pages. You can't 
add traditional pages. For information about adding mobile pages, see Adding Mobile 
Pages. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. Click Pages, and then select Add Pages. 

5. Select the type of page you want to add, and then complete the appropriate steps: 

o Blank Page — To add a page without content, select Blank Page. 
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o Pre-Built Page — To add a page with content from a pre-built template, go to 
the Category menu, and then select a category. From the Page menu, select a pre-
built page. 

o Copy of existing page — To add a copy of one of your existing pages, select the 
copy. 

o Photo page — Adds a page optimized for an image gallery. 
o Blog page — Adds a page optimized for a blog. 

6. Click Add Page. 

7. In the Page Title field, enter a title. 

8. From the Copy navigation from menu, select a page to copy. 

9. If you want to add the page your site's navigation menu, select Include in Site 
navigation. 

Note: To add multiple pages, click Add Page again and then complete the fields. 

10. Click OK. 

 

To Delete Multiple Pages 
 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. If you are working in the Page Designer, click Exit Designer. 

4. From the Manage menu, select Organize Site . 

5. Click the Red X next to the pages you want to delete, and then click OK to confirm the 
deletion. 
 

Note: To delete a Guest Book page, click the page's left-side gear button and 
choose Deactivate Guest Book. 
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To Delete a Page 
 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. In the Jump to page: menu, select the page you want to delete. The Page Designer 
opens. 

4. If you are working in the Page Designer, select the page you want to delete. 

5. From the Pages menu, click Delete Page. 

6. Click OK to confirm the deletion. 

 

To Organize Pages 
 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. If you are working in the Page Designer, click Exit Designer. 

4. From the Manage menu, select Organize Site. 

5. To change the order of your pages, select and drag pages in the order you want them to 
display. 

6. To set one of your pages as the home page, select the page, and then select Make this 
page the Home Page. 

7. To exclude one of your pages from being published, select the page, and then select Do 
not publish this page. 

8. To change properties for a page, select the page, and then do the following: 

o In the Navigation Title field, enter the name you want to display on the button that 
links to it. 

o In the Browser Title field, enter the title you want to display in browsers. 
o In the Heading Title field, enter a heading for the page. 



Website Builder 6 Help Guide                                                                                                            24 
 

o In the Filename field, enter a name to display in the page's URL. 
o To automatically reset the navigation buttons to reflect the changes, select Restore 

default navigation. 

Note: This will overwrite any settings or subnavigation you added from the Edit 
Navigation page. 

9. Click OK. 

10. To confirm your changes, click OK. 

 

 

Adding Mobile Pages 
 

With Website Builder, you can add mobile pages for viewing on mobile devices. Pages set up 
with this feature will display on non-smartphone devices. For information about mobile websites 
optimized for smartphones, see Working with Mobile Websites. 

Note: You can add an unlimited number of pages to your Website Builder account, but can only 
publish the number of pages that your plan allows. If you have a .mobi domain name, you can 
only add mobile pages; you cannot add traditional pages. For information about adding 
traditional pages, see Adding, Deleting, and Organizing Pages. 

 

To Add a Mobile Page 

 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. Click Pages, and then select Add Mobile Page. 

5. Select one of the following, and then click Add Page: 

o Blank Page — Design your new mobile page from a blank template. 
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o Copy of existing page — Once you have designed other mobile pages, you can 
select one of them to create a new page that is a carbon copy of it. 

6. Complete the following, and then click OK: 

o Page Title — Enter the title you want to display for the page. 

o Copy navigation from — Select a page which uses the same navigation links as 
you want for this page. 

o Include in Site navigation — Select to include this page in your website's 
navigation links. 

 

 

Working with Mobile Websites 
 

When you publish your website, Website Builder also creates a mobile version. It doesn't 
require any extra steps from you. If you prefer not to have a mobile version of your website, you 
can easily disable it. 

With Business and Business Plus accounts, you can customize your mobile website. If you don't 
like your changes, they're easy to reset. 

Mobile websites are optimized to display on mobile devices such as smartphones. When visitors 
come to your website on their mobile devices, they see a version that's easier to view and 
navigate. 

With the widespread use of mobile devices these days, a mobile-friendly website can increase 
traffic to your site — and its overall success. 

Note: You must publish your standard website for your mobile website to display.  

 

Customizing Mobile Websites 
 

With Deluxe and Premium accounts, you can customize your mobile website. If you don't like 
your changes, they're easy to reset. 

Note: When editing mobile websites, we recommend using Mozilla Firefox®, Google 
Chrome®, or Internet Explorer® 9 and higher. 
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To Customize Mobile Websites 

 

1. Log in to your Website Builder account. 

2. Click Design Your Pages. 

3. Click Mobile. 

4. To change the layout and colors, click Select Layout, and then select the options you 
want to use. 

5. To edit your mobile site, click Edit Site, and then select one of the following: 

o Basic — Edit the basics, such as the logo, navigation, text and images, click-to-call 
button, and mobile maps. 

o Full — Edit everything, including background text, images, and website apps. 

6. To preview how your mobile website displays on mobile devices, click Preview, and then 
a mobile device. 

7. To see your changes online, you must publish your website. 

 

Disabling or Resetting Mobile Websites 
 

If you prefer not to have a mobile website, you can disable it. You can also reset your mobile 
website to remove any customization you added. When you reset or disable your mobile 
website, you cannot restore any customization you created. 

 

To Disable or Reset a Mobile Website 

 

1. Log in to your Website Builder account. 

2. Click Design Your Pages. 

3. Click Mobile. 

4. Click Settings in the lower left corner, and then do one of the following: 

o To disable your mobile website, click Disable, and then click OK to confirm the 
action. 

o To reset your mobile website, click Reset, and then click OK to confirm the action. 
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Setting Up a .MOBI Domain 
 

When setting up Website Builder with a .mobi domain, you can create a website properly 
formatted for smaller screens. Pages set up with this feature will display on non-smartphone 
devices. For information about mobile websites optimized for smartphones, see Working with 
Mobile Websites. 

 

To Set Up a .MOBI Web Page 
 

Note: With .MOBI domains, you can only add mobile page layouts; you cannot add 
traditional page layouts. 

1. Log in to your account. 

2. Click Website Builder©. 

3. Next to the account you want to use, click Manage. 

4. If you accept the terms of the End User License Agreement, click Accept. 

5. On the Site Settings page, complete the following fields and then click Next: 

Select an available domain from your account 

Select an existing domain name from the list. 

Enter a domain not registered in this account 

Enter your domain name in the space provided. 

Enter a subdomain 

Enter your subdomain name in the space provided and select an existing domain 
name from the list. 

User Name 

Create a user name that you will use when logging in to your Website Builder 
site. 

Password and Confirm New Password 

Create and verify the password that you will use when logging in to your Website 
Builder site. 
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Email Address 

Forms submitted through your site will be sent to this email address 

Company or Individual Name 

Your company or individual name will be displayed in the footer of each Web 
page 

6. On the Build Your Site page, select one of the following: 

Pre-built Site 

If you are setting up a site for a .mobi domain, this option is disabled. 

Blank Site 

Selecting Blank Site will allow you to build a site from scratch. If you want to add 
pages to your website, click Add Page and enter a title for you page. This step is 
optional. You can also change the layout of each page of your site by 
clicking Change Layout for the page you want to change. You can add pages or 
change your layout at any time. 

7. Click Finish. 

Congratulations! You have successfully set up your .mobi website. You can continue to the Page 
Designer to begin building your site by clicking Build My Site. 

 

To Change Your Layout 
 

1. On the Build Your Site page, click Change Layout. 

2. Scroll through the available layouts by clicking the forward and back arrows or by 
clicking on the page numbers above the layout thumbnails. 

3. Click on a layout to select it, and then click OK. 

Your website will not display on the Internet until you publish your site. 
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Using Drag-and-Drop 
 

Website Builder uses a drag-and-drop interface to design your website. With drag-and-drop, 
customizing your website is fast. It doesn't require that you have any programming or coding 
experience. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Current Page menu, select the page that you want to modify. 

5. Click either Popular, Media, Social, Apps, or Tables & Forms, and then drag and drop 
the icon for each element you want to add over a Drop Zone. Drop Zones display on 
your Web pages when you hover over them. 

 

 

Adding and Editing Text 
 

Website Builder provides common tools for adding and editing your text. Using the text toolbar, 
you can customize fonts and the way your text is organized. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Current Page menu, select the page that you want to modify. 

5. Click the content block you want to edit, position your cursor where you want, and then 
enter the text you want to add. 

6. Highlight the text you want to edit, and then use the text toolbar to edit text properties 
such as font type, font size, font color, text alignment, hyperlinks, and anchors. 

7. To let the text toolbar scroll with the page, click the  icon. 

8. To pin the text toolbar in a specific location on your page, click the  icon. 
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9. To lock the text toolbar in place when scrolling, click the  icon. 

10. To accept the changes to your text, click the Save icon. 

 

 

Spell Checking 
 

Website Builder allows you to check the spelling of text on your web pages. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page you want to edit. 

5. Click the block you want to edit. Blocks are outlined in blue. The text editing window 
opens. 

6. From the formatting toolbar on the top left of the page, click Spell Check. (The check 
mark with ABC) 

7. If errors are found, you can view the following information: 

Word Not in Dictionary area 

The misspelled word 

Change To 

The suggested replacement for the word 

Suggestions 

List of suggestions for replacing the word 

8. To fix spelling in the word, either change the spelling in the Change To field or select the 
word from the Suggestions list. 

9. Select one of the following: 

Ignore 

Ignores the word 
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Ignore All 

Ignores all instances of the word 

Add to Dictionary 

Adds the word to the dictionary so it does not display as a misspelled word 

Replace 

Replaces the word 

Replace All 

Replaces all instances of the word. 

10. Website Builder continues checking the spelling in the content block. When finished, the 
Spell Check Complete popup window displays. 

11. Click OK. 

 

 

Working with Content Blocks 
 

In Website Builder, you manage your text, images and apps in content blocks. You can also 
share content blocks to display identical content in different places on your website. 

 

Adding Content Blocks 
 

You can add content blocks where you want on your Web page. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page you want to modify. 

5. Click Popular, and then drag and drop the Content Block icon over a Drop Zone. Drop 
Zones display on your Web pages when you hover over them. 
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6. Enter the text or design elements you want, and then click the Save icon. 

 

Deleting Content Blocks 
 

You can delete a content block and permanently remove the entire block from your page. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page you want to modify. 

5. Go to the content block you want to delete, hover your mouse over the gear icon, and 
then click Delete Block. 

6. Click OK. 

 

Sharing Content Blocks 
 

You can share a content block. Sharing lets you place the same content on multiple pages. Any 
changes you make to a shared block will affect all of those shared blocks. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page you want to modify. 

5. Go to the content block you want to share, hover your mouse over the gear icon, and 
then click Save/Insert. 

6. To create new shared content, in the Share Block section, enter a name for your shared 
content block, and then click Create Shared Content. 
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7. To insert existing shared content, in the Select Shared Block section, from 
the Content menu, select the name of the content you want to insert, and then 
click Insert Shared Content. 

8. Click OK. 

 

Clearing Content from Content Blocks 
 

Clearing a content block removes only the content of the block. The block remains. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page you want to modify. 

5. Go to the content block you want to clear, hover your mouse over the gear icon, and 
then click Clear. 

6. Click OK. 

 

Moving Content Blocks 
 

You can move a content block to a different location on a Web page. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page you want to modify. 

5. Place you mouse over the block you want to move, click and hold the Move icon, and 
then drag the content block over a Drop Zone. Repeat as necessary. 
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Editing the Design of Content Blocks 
 

You can edit a content block's properties, such as its background color or its border. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page you want to modify. 

5. Go to the content block you want to edit, hover your mouse over the gear icon, and then 
click Block Designer. 

6. From the Block Designer toolbar, perform any of the following actions: 

o Adjust Background Color — Select a color to fill the background of the content 
block. 

o Adjust Border Color — Select a color for the border of the content block. 

o Adjust Border Weight — Select a thickness for the border of the content block. 

o Adjust Border Style — Select a solid, dotted, dashed, or double border. 

o Adjust Cell Spacing — Select a width for the space between the block and its 
contents. 

o Adjust Cell Padding — Select a width for the space between content blocks. 

7. To preview your changes, click Preview. 
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Adding Columns 
 

You can add multiple columns to your Web pages in Website Builder. Columns are spaces 
within content blocks where you can add page elements. These include text, images, or apps. 
You can add or delete columns to create dynamic and unique page layouts. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page you want to modify. 

5. Click Popular, and then drag and drop the Columns icon over a Drop Zone. Drop Zones 
display on your Web pages when you hover over them. 

6. Mouse over the content block with columns, and then select the number of columns you 
want. 

7. If you want to change the width of columns, mouse over that content block, click 
the Column Width icon, and then drag it to the width you want. 

8. To delete all of the columns in a content block, mouse over that content block, and then 
click the Delete icon. To see the changes online, you must publish your website. 
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Managing Links and Anchors 
 

With Website Builder you can insert hyperlinks and anchors to your Web pages. You can add 
hyperlinks to text and images. 

 
Inserting a Hyperlink 
 

With Website Builder, you can insert hyperlinks into your content blocks. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. From the Design menu, click Launch Page Designer. 

4. If necessary, from the Page list, select the page you want to edit. 

5. Click the block you want to edit. Blocks are outlined in blue. 

6. Position your cursor where you want to add the hyperlink and highlight the text or image 
you want to make into a hyperlink. 

7. Click the Create Link icon. (The chain link icon.) 

8. From the Link to area, select one of the following: 

o Email — Link to an email address. 
o URL — Link to a website. 

Note: You can also add other information by deleting the text in the URL and Email 
fields and adding your own information. 

o Page — Link to another page in your website. 
o Upload — Link to a file you uploaded to Website Builder. 

Note: If you haven't uploaded the file you want to create a hyperlink to, you should 
upload the file first. For more information, see Uploading and Linking to Files. 

o Anchor — Link to an anchor on your website. 
o Open in new window — Sets the item to automatically open in a new window. 
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9. Optional: To prevent search engines from factoring the hyperlink into their rankings, 
select No Follow. 

10. Click OK. 

Note: To remove a hyperlink, you must delete the text or image containing the hyperlink. 

 

Adding an Anchor 
 

With Website Builder, you can add anchors to your Web pages. 

You can use an anchor to link to a specific area on a page. You insert the anchor in the area you 
want to link to, and then you can add a hyperlink to that anchor. When visitors click the 
hyperlink, they are taken to the area on the page where you inserted your anchor. 

To Add an Anchor 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. From the Design menu, click Page Designer. 

4. If necessary, from the Page list, select the page you want to edit. 

5. Click the block you want to edit. Blocks are outlined in blue. 

6. Position your cursor where you want to add the anchor. 

7. Click the Create Anchor icon. 

8. In the Anchor Name field, enter the name you want to assign to the anchor. 

9. Click OK. 
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Linking to an Anchor 
 

With Website Builder, you can link to the anchors on your Web pages. 

To Link to an Anchor 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. From the Design menu, click Page Designer. 

4. If necessary, from the Page list, select the page you want to edit. 

5. Click the block you want to edit. Blocks are outlined in blue. 

6. Position your cursor where you want to add the hyperlink and highlight the text or image 
you want to make into a hyperlink. 

7. From the formatting toolbar, above the header, click the Create Link icon. (The icon with 
the globe) 

8. Select Anchor. 

9. Select the name of the anchor you want to link to. 

10. Click OK. 

 Note: You cannot link to anchor in the same block as the hyperlink. 
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Hiding Web Pages 
 

If you want to display your website with some Web pages removed temporarily, Website Builder 
lets you hide those pages. 

Each time you re-publish your site, you can select which pages display live on the Internet, while 
those you did not remain visible only in Website Builder's Page Designer. You can continue 
working on unpublished pages until you want to publish them. 

You can also hide a live page on your website by removing it from your navigation menu. For 
more information, see Changing Your Site's Navigation. 

To Unpublish Pages 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. If you are working in the Page Designer, click Exit Designer. 

4. From the Manage menu, select Publish Selected Pages. 

5. Select the pages you want to display live on the Internet, and then click Publish Selected 
Pages. 

6. The pages you did not select remain hidden, while the pages you did display live on the 
Internet. 
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Changing Your Site's Navigation 
From the Edit Navigation window in Website Builder, you can change your site's navigation 
buttons. You can apply your changes across all of the pages in your website or just individual 
pages. You can also add subnavigation buttons, which display below main navigation buttons. 

Note: Subnavigation is not supported on Economy Website Builder plans. 

1. Log in to your account and open your product. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Current Page menu, select the page that you want to modify. 

5. Click Pages, and then select Navigation. 

6. Select the navigation button that you want to change. 

7. From the Link Type menu, specify the kind of link you want to set for the button: 

o Email — Creates a mailto: link to a designated email address. For example, 
name@coolexample.com. 

o Page — Links to another page within your website. 
o URL — Links to any valid URL that you specify. For example, 

http://www.google.com. 
o Upload — Opens a file that you have uploaded to your account. This option is 

available only if you have uploaded files to your Website Builder account. 
o Anchor — Jumps to an anchor link on a specific page. This option displays if one of 

your pages contains an anchor link. 
o Store — Links to your Quick Shopping Cart® storefront. This option is available only 

if you have a Quick Shopping Cart account in the same account as your Website 
Builder account. 

8. In the Goes To section, either enter an email address, select a page, enter a URL, select 
a file to open or select the store where you want your navigation to go. 

9. In the Navigation title field, enter a title for the navigation button. 

10. To automatically load the page in a new browser window, select Open In New Window. 

11. To apply your navigation menu changes to all of the pages in your website, from the 
Apply to menu, select All Pages. 
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12. To apply your navigation menu changes to the page you selected, from the Apply to 
menu, select This Page. 

13. To add a navigation button, click Add Navigation. 

14. To add a subnavigation button, click Add Subnavigation. 

15. To edit a navigation button, select the navigation button name you want to edit, update 
the button properties as necessary, and then click Apply. 

16. To change the order in which navigation buttons display, select and drag the button 
name you want to move to the location where you want it to display in the organization 
tree. 

17. To delete a navigation button, click the Delete icon next to the navigation item you want 
to remove. 

18. Click Apply and then click OK. 

 

 

Uploading and Linking to Files 
 

With Website Builder, you can upload files to your account and create direct links from your 
Web pages to those files. For example, you can link to a PDF file that displays a restaurant 
menu. When you no longer use files, you can delete them. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page you want to modify. 

5. Click Popular, and then drag and drop the File icon over a Drop Zone. Drop Zones 
display on your Web pages when you hover over them. 

6. Do one of the following: 

o Select an existing file — From the File Name list, select the file you want to insert. 
The link to your file displays on your Web page. 

o Upload a new file — Click Browse, select the file you want to upload, and then 
click Open. The link to your file displays on your Web page. 
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To Upload Images as Files for Linking 
 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. If you are working in the Page Designer, click Exit Designer. 

4. From the Manage menu, click Upload Files. 

5. Select Place images in files folder. 

6. Click the Browse button. 

7. Locate and select the file you want to upload, and then click Open. To select multiple 
files, hold the Ctrl key while selecting files. 

8. Click Upload. 

 

To Delete Files 
 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. If you are working in the Page Designer, click Exit Designer. 

4. Go to the Manage tab, and then select Upload Files. 

5. From the Files tab, select the files you want to delete, and then click Delete. 

Note: Once you've deleted files, they're no longer available on your site or in 
applications where you shared them. 
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Adding Tables and Forms 
 

Website Builder lets you add tables that give you more control over how your text and images 
display, and forms to let your website's visitors submit data to you. 

You can also add pre-built tables and forms such as contact forms, event schedules, coupons, 
loan application forms, loan calculators, domain name search forms, biographies, and birth 
announcements. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page that you want to modify. 

5. Click Tables & Forms, and then drag and drop the Table icon over a Drop Zone. Drop 
Zones display on your Web pages when you hover over them. 

6. Complete the following fields: 

o Rows — Specify the number of rows you want. 
o Columns — Specify the number of columns you want. 
o Width — Specify the width of the table in percent, pixels, or em. 
o Alignment — Select an option for aligning the table on the page. 
o Border thickness — Specify the thickness you want to use. 
o Cell spacing — Specify the amount of space between the table's cells. 
o Cell padding — Specify the amount of space between the cell border and the text. 

7. Click OK. 

 

To Add a Table Using the Table Wizard in Website Builder 
 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page that you want to modify. 
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5. Click Tables & Forms, and then drag and drop the Table Wizard icon over a Drop Zone. 
Drop Zones display on your Web pages when you hover over them. 

6. Go to the Table Design tab, enter the number of columns and rows you want to use, and 
then click the plus or minus signs to increase or decrease the span of the columns and 
rows space. 

7. Go to the Table Properties tab, and then select the height and width of your table from 
the Dimensions section. 

8. From the Layout section, select your cell spacing and padding, alignment, background 
color and border thickness. 

9. From the CSS Class Layout section, select your layout from the drop-down menu, and 
then select any special formats you want to use. 

10. Go to the Cell Properties tab, and then preview what your table looks like from the 
Preview section. 

11. From the Cell Properties section, specify the cell height and width, content alignment, 
and background color, and then click OK. 

 

To Add a Form in Website Builder 
 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page that you want to modify. 

5. Click Tables & Forms, and then drag and drop either the Contact Form, Blank Form 1, 
or Blank Form 2 icon over a Drop Zone. Drop Zones display on your Web pages when 
you hover over them. 

6. To edit a form, click on the form that you want to edit. 

7. Click the gear icon, and then select Edit Form. 

8. From the Insert Field list, select one of the following: 

o Text Box — Adds a text box to the form. 
o Text Area — Adds a text area to the form, which is larger than a text box. 
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o Radio Button — Adds a radio button for selecting form options. 
o Check Box — Adds a check box for selecting form options. 
o List — Adds a list to the form. 
o Normal Button — Adds a generic button the form. 
o Submit Button — Adds a submit button to your form. 
o Reset Button — Adds a button that lets the user clear the information entered in the 

form. 
o Date Selector — Adds a calendar to the form to select dates. 
o Captcha — Adds a captcha code generator to the form. 

9. Enter a label for the new element, and then click Add. 

10. If you want to direct your website's visitors to a specific page after they submit forms, 
from the On form submittal go to section, either select one of your pages from 
the Page menu or select Other and enter a URL. 

11. If you want to specify the email address where your forms are submitted, next to Email 
to, enter an email address. 

12. Click OK. 

 

To Add a Pre-Built Table or Form in Website Builder 
 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page that you want to modify. 

5. Click Tables & Forms. 
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6. Drag and drop one of the following icons over a Drop Zone, and then update the item 
accordingly: 

o Event Schedule — Adds a table that displays a schedule of events. 
o Coupon Design 1 — Adds a coupon with a popular design for websites. 
o Coupon Design 2 — Adds a coupon with a popular design for websites. 
o Loan Application Form — Adds a form for a standard loan application. 
o Loan Calculator — Adds a calculator for determining loan payment amounts. 
o Property Price Calculator — Adds a calculator for determining property prices. 
o Domain Search — Adds a box to your website for completing domain searches for 

new registration. 
o Biography — Adds a pre-built layout for a biography page. 
o Baby Announcement — Adds a pre-built layout for a baby announcement page. 

 

 

Adding Form Elements 
 

Website Builder gives you the tools you need to build a form that visitors can complete and 
submit. You can choose from a form template, build your own custom form, or a combination of 
both. 

After adding a form, you can add form elements to it, such as a drop-down list, a radio button, 
a calendar selector, or a text box. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Current Page menu, select the page that you want to modify. 

5. Select the content block that contains the form, and then click on the form you want to 
edit. 

6. Click the gear icon, and then select Edit Form. 
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7. From the Insert Field list, select one of the following: 

o Text Box — Adds a text box to the form. 
o Text Area — Adds a text area to the form, which is larger than a text box. 
o Radio Button — Adds a radio button for selecting form options. 
o Check Box — Adds a check box for selecting form options. 
o List — Adds a list to the form. 
o Normal Button — Adds a generic button the form. 
o Submit Button — Adds a submit button to your form. 
o Reset Button — Adds a button that lets the user clear the information entered in the 

form. 
o Date Selector — Adds a calendar to the form to select dates. 
o Captcha — Adds a captcha code generator to the form. 

8. Click Add. 

9. Enter a label for the new element. 

10. Click OK. 

 

 

Adding Radio Buttons 
 

A form element is part of a form. You must add a form before you can add elements to. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page that you want to modify. 

5. Click the content block that contains the form you want to edit, and then click the form. 

6. Hover your mouse over the gear icon, and then select Edit Form. 

7. From the Insert Field menu, select Radio Button. 

8. In the Label field, enter the text you want to display with the radio button, and then 
click Add. 
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9. To set properties for the radio button, modify the following fields from the Radio Button 
Properties section: 

o Label — Edits the radio button label. 
o Tooltip — Edits the tooltip that displays when users hover over the radio button on 

your website. 
o Value — Specifies the information you want to submit when the radio button has 

been selected. For example, if the label is "Add me to your contact list", the value 
may be "True", specifying that when the radio button has been selected, the user 
wants to be added to your contact list. 

o Group — Specifies a group label if you have a group of buttons. For example, if you 
listed radio buttons where users can select a color, such as pink, green, and blue, 
you might want to call the group "Color". 

o Selected — Automatically shows the radio button as selected. 
o Move Up — Moves the radio button above the previous item in the form. 
o Move Down — Moves the radio button below the next item in the form. 

10. When finished, click OK. 

 

 

Adding CAPTCHA to a Form 
 

You can add a CAPTCHA box to your Website Builder forms to prevent computer-generated 
spam. A CAPTCHA box displays distorted text that humans can read, but computers cannot. 
This helps reduce the amount of spam reaching your inbox. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page that you want to modify. 

5. Select, and then double-click, the form that you want to edit. 
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6. From the Insert Field menu select CAPTCHA and click Add. 

7. If necessary, make other changes to your form. 

8. Click OK. 

Note: The CAPTCHA does not display when previewing your site. To see it, publish the 
site and view it live. 

 
 

Specifying Email Address in a Form 
 

You can change the email address to which a Website Builder form is sent by using the Edit 
Form page. If you have multiple forms on your site, you can send each form to a different email 
address, if desired. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. From the Design menu, select Launch Page Designer. 

4. If necessary, from the Page list, select the page you want to edit. 

5. Click the block you want to edit. Blocks are outlined in blue. 

6. Double click the form you want to edit, and click Edit Table. 

7. Go to the Options tab, and then select Edit Form. 

8. In the Email to: field, enter the email address you want your form sent to. 

9. Click OK. 
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Adding Image Galleries in Website Builder 
 

Image galleries are collections of images that you can add to your Web pages in Website 
Builder. You can also manage the layouts of your image galleries with features such as 
Lightbox. 

To Add an Image Gallery 

1. Log in to your Website Builder account. 

2. Click Design Your Pages. 

3. If necessary, from the Current Page menu, select the page that you want to modify. 

4. Click Popular, and then drag and drop the Image Gallery icon over a Drop Zone. Drop 
Zones display on your Web pages when you hover over them. 

5. Select a source for creating your image gallery, and then complete its steps: 

o Gallery — Lets you import images from image gallery accounts to create your 
collection. Select the image gallery account you want to import and the specific 
gallery that contains the images you want, click Add, and then click OK. 

o Individual — Lets you insert individual images from the Image Library or images 
that you uploaded to create your collection. Click Select Images, select the 
images you want to use, and then click OK. 

6. To manage display options for your image galleries, go to the Settings tab, select the 
option you want to use, and then perform the steps for that option: 

o Thumbnails — Displays image galleries in thumbnail sizes. 

 To display image titles when visitors mouse over images, from the Show 
image titles menu, select Yes. 

 Select the Columns and Rows you want to display. 

 To re-shape images after cropping, from the Image resizing menu, 
select Square, Portrait, or Landscape. 

 Go to the Preview tab, and then make sure your image collection displays 
correctly. 

 Click OK. The image collection displays in your content block. 

o Slideshow — Displays image galleries in a slideshow. 
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 To display image titles with slideshows when visitors mouse over images, 
from the Show image titles menu, select Above or Below. 

 To display a bar letting visitors scroll slideshows, select Show control bar. 

 From the Control Bar Location menu, select where you want to display 
the control bar. 

 Go to the Preview tab, and then make sure your image collection displays 
correctly. 

 Click OK. The image collection displays in your content block. 

o Animated slideshow — Displays image galleries in an animated slideshow. 

 From the Image Size menu, select a size for the images. 

 To expand images to fill the entire slide, select Scale images. 

 From the Slide Speed menu, select a speed for images to play. 

 For slideshow to start playing when visitors reach the page, select Auto 
Play. 

 From the Effects menu, select an animation effect. 

 To display image titles when visitors mouse over them, from the Show 
image titles menu, select Above or Below. 

 To display a bar that lets visitors scroll through the slideshow, 
select Display Control Bar. 

 From the Control Bar Location menu, select where you want to display 
the control bar. 

 From the Thumbnail Strip menu, select where you want to display 
thumbnail images. 

 From the Thumbnail Size menu, select a size for the thumbnails. 

 To expand your images to fill the entire thumbnail, select Scale 
Thumbnail. 

 Go to the Preview tab, and then make sure your image collection displays 
correctly. 

 Click OK. The image collection displays in your content block. 

o Lightbox — Displays image galleries in a window over Web pages. 
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 From the Image Size menu, select Small, Medium, Large, or Custom. 

 To display image titles when visitors click images, from the Show image 
titles menu, select Yes. 

 Go to the Preview tab, and make sure your image collection displays 
correctly. 

 Click OK. The image collection displays in your content block. 

To see your changes online, you must publish your website. 

 

 

Changing the Default Photos and Videos View 
 

In Website Builder you can customize the default view of your photos and videos. Choose 
between thumbnail, filmstrip or slideshow view. You can also specify the number of photos that 
display in the thumbnail view. You can view 12, 24, 48 or 60 at a time. 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. From Site Menu, click Photos and Videos. 

5. From the Default Media View list, specify whether you want your view to default to the 
Thumbnail, Filmstrip, or Slideshow tab. 

6. From the Gallery view, select the number of thumbnails you want to display. 

7. Click Save. 
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Setting Gallery Display Order 
 

With Website Builder, you can sort photo galleries by the date on which they were created, by 
gallery name, or manually set the gallery order. 

To Set Gallery Display Order in Website Builder 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Photos and Videos. 

5. From the Galleries menu, select Edit Galleries. 

6. Click Change Gallery Order. 

7. Select one of the following: 

o Date created (oldest first) — Lists galleries in order of date, with the oldest gallery 
displaying at the top of the list 

o Date created (most recent first) — Lists galleries in order of date, with the most 
recent gallery displaying at the top of the list 

o Name (A-Z) — Lists galleries in alphabetical order, with "A" displayed at the top of 
the list 

o Name (Z-A) — Lists galleries in alphabetical order, with "Z" displayed at the top of 
the list 

o Manually set gallery order — In the Order column, set the numbered position in 
which you want each gallery to display 

8. Click Save Changes. 
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Creating Galleries 
 

Website Builder galleries let you organize your photos or videos into categories, creating 
multiple galleries, and then uploading photos and videos to them. 

You can make your galleries public, private, or password-protected. For private or password-
protected galleries, an icon displays below the name of the gallery to indicate it is protected. 

You can create a gallery and add photos or videos later. For more information about adding 
photos or videos at a later time, see Adding Photos to Galleries in Website Builder. 

To Create a Photo or Video Gallery 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Go to Photos and Videos, and click Create Gallery. 

4. In the Gallery name field, enter the name of the gallery. 

5. In the Gallery description field, enter a description for your photo gallery. 

6. In the Privacy settings area, select one of the following: 

o Public — Makes the gallery available for public view. 
o Private — Makes the gallery private so only you can view it. 
o Password protected — Makes the gallery accessible only to visitors who enter the 

correct password. 

7. Click Create Gallery to create your gallery and add photos or videos later, or 
click Create and Upload Files to create a gallery and add photos or videos to it. 
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Adding Photos to Galleries in Website Builder 
 

In Website Builder you can upload photos to galleries individually using the Basic Uploading 
Tool, or you can upload multiple photos at once with the Advanced Uploading Tool. 

Note: The Advanced Uploading Tool requires Flash® Image Uploader. 

To use the Advanced Uploading Tool, follow the directions on the Upload page. If you do not 
see any information under Step 2. Select and upload your photos and videos, you must re-install 
the Image Uploader ActiveX control or use the Basic Uploading Tool. 

If you use the Basic Uploading Tool, individual files you upload can be up to 50 MB in size. 
When using the Advanced Uploading Tool, your files upload in pairs. It uploads the first two 
files, then the next two, and so forth. The combined file size of each pair can be up to 50 MB. 

You can upload photos in JPG, BMP, or GIF file formats. 

 

To Add Photos Using the Basic Uploading Tool 
 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. Next to the account you want to use, click Manage. 

4. Click Photos and Videos, and then click Upload. 

5. Click 'basic uploading' tool. 

6. From the Select a gallery list, select the gallery you want to upload the photos to. 

7. Click Browse, and then locate and select the photos to upload. 

8. Click Upload. 
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To Add Photos Using the Advanced Uploading Tool 
 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Upload. 

5. If this is the first time you've accessed the Upload page, follow the instructions for 
running the Image Uploader ActiveX control. 

6. From the Select a gallery list, select the gallery you want to upload the photos to. 

7. Click Browse. 

8. Locate and select the photos you want to upload, and then click Open. To select multiple 
files, hold the Ctrl or Shift key while selecting the files you want to upload. 

9. Click Upload. 

 

 

Deleting Photo Galleries 
 

Before deleting Website Builder galleries, you should move the photos to another gallery or they 
will be deleted, too. For more information about moving photos, see Organizing Gallery Items. 

To Delete Photo Galleries in Website Builder 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Photos and Videos. 

5. From the Galleries menu, select Edit Galleries. 

6. Select the gallery or galleries you want to delete. 
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7. From the Apply this action list, select Delete. 

8. Click Go. 

9. In the Delete Galleries dialog box, type Yes. 

10. Click OK. 

 

 

Adding and Editing Photo Captions and Titles 
 

By default, Website Builder uses the photo's file name as the title, but you can edit it at any 
time. You can also add and edit a photo caption. 

If you use the Advanced Uploading Tool to add photos, you can edit the title before you upload 
the photo. For more information, see the "To Add Photos to a Photo Gallery Using the 
Advanced Uploading Tool" section in Adding Photos to Galleries in Website Builder. 

To Add and Edit Photo Captions and Titles in Website Builder 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Photos and Videos, and then select the gallery you want to view. 

5. Click the photo title. The title displays in a text box, and a caption text box displays 
below it. 

6. Update the title and caption as necessary. 

7. Click Save. 
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Adding and Editing Image Text 
 

Website Builder lets you to add text to images, such as captions, photo credits, descriptions 
and more. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. From the Design menu, click Launch Page Designer. 

4. If necessary, from the Page list, select the page you want to edit. 

5. Click the block you want to edit. Blocks are outlined in blue. 

6. Double click the image you want to edit. 

7. Click the Text Overlay tab. 

8. From the Font list, select the font you want to use. 

Note: If you have not downloaded fonts from Website Builder, the text box will not show 
the font style. You can see the font style when you click Update Image Preview. For 
more information about downloading fonts, see Downloading Additional Fonts for your 
Website. 

9. From the Size list, select the font size you want to use. 

10. From the Color list, select the font color you want to use. 

11. To make the text bold or italic, click Bold or Italic. 

12. To underline the text, click Underline. 

13. To insert a variable, from the Insert Variable list, select the variable you want to insert. 

14. In the text box, type your text. 

15. From the Text Position list, select where you want to position the text on the image. 

16. To preview the changes, click Update Image Preview or Preview Full Size. 

17. Click OK. 
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To Edit Text on an Image 

 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. From the Design menu, click Launch Page Designer. 

4. If necessary, from the Page list, select the page you want to edit. 

5. Click the block you want to edit. Blocks are outlined in blue. 

6. Select the image you want to edit. 

7. Go to the Options tab, click Edit Image. 

8. Click Image Text. 

9. Select the text you want to edit. 

10. Edit the text. 

11. To preview the edited text, click Update Image Preview or Preview Full Size. 

12. Click OK. 

 

 

Downloading Additional Fonts to Website Builder 
 

You can choose from over 150 font styles to use when adding text to your Website Builder 
images. Many of these images are default headings in your Web page templates, which you can 
customize to your style by using unique fonts. You create these headings as images so they 
display correctly on other computers, whether the font is available on another user's computer. 
These fonts are not available for use as normal text. 

Because these fonts reside on our servers, you can only view them if you download the fonts or 
when you preview the image or add it to a page. 

Note: You can only download fonts for Website Builder using Microsoft® Windows 
operating systems. 
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To Download Font Styles 

1. Log in to your Website Builder account. 

2. If you are working in the Page Designer, click Exit Designer. 

3. From the Manage menu, select Fonts. 

4. Click Download Fonts. 

5. Click Run to install the fonts to your computer. 

After you download the fonts, you can view them as you edit an image. For more information, 
see Adding Text to Images. 

 

 

Add image mouseover 
 

With Website Builder you can add effects to images added to your Web page. When you apply 
a mouseover effect to an image, the image changes when a visitor moves their mouse over it. 
To add a mouseover effect, you select an image that displays by default, and one that displays 
when a mouse goes over it. 

 

To Add or Modify a Mouseover Effect on an Image 
 

1. Log in to your Website Builder account. 

2. Click Design Your Pages. 

3. If necessary, from the Page menu, select the page you want to edit. 

4. Click the block that contains the image you want to edit. Blocks are outlined in blue. 

5. Select the image you want to edit. 

6. Go to the gear icon, and then click the Edit Image. 

7. Select Mouseover, and then select either Add Mouseover or Replace Image. 

8. From the Image Library, locate and select the image you want to use, and then click OK. 
For more information about using the Image Library, see Editing Image Galleries. 
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9. Select either Original or Mouseover, and then select any image editing option to make 
changes to the image. 

10. Click Save. 

 

To Remove a Mouseover Effect from an Image 
 

1. Log in to your Website Builder account. 

2. Click Design Your Pages. 

3. If necessary, from the Page menu, select the page you want to edit. 

4. Click the block that contains the image you want to edit. Blocks are outlined in blue. 

5. Select the image you want to edit. 

6. Go to the gear icon, and then click the Edit Image. 

7. Select Mouseover, and then select Remove Mouseover. 

8. Click Done, and then click Save. 

 

 

Viewing Photos and Videos 
 

When viewing your photos or videos in Website Builder, you can select the view in which you 
want your photos and videos to display. 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Photos and Videos, and then click the name of the gallery you want to view. 

5. Change the view by clicking one of the following tabs: 

o Thumbnails — Displays the photos and videos as thumbnails. If you click on a 
video thumbnail, it plays. 
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o Filmstrip — Displays photos and videos in a filmstrip. Click a photo to view it or 
click a video to play it. Click the arrows to view the previous or next photo or 
video in the filmstrip. 

o Slideshow — Displays photos and videos in a slideshow. Videos play 
automatically in the slideshow. Use the controls below the slideshow to stop, 
play, or view the previous or next photo or video in the slideshow. You can also 
adjust the speed of the slideshow using the slider. Slideshows can also play 
music. For more information, see Adding Music to Your Photo Slideshow. 

 

 

Adding Music to Your Photo Slideshow 
 

Website Builder offers a variety of music tracks to play during your slideshows. You can select 
from several built-in tracks, and you can upload your own music. When you play or share a 
slideshow, the music you select plays in the background. 

For information about uploading music, see Managing Photo Album Music in Website Builder. 

To Add Music to Your Photo Slideshow 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Photos and Videos, select a Gallery and then click Slideshow. 

4. From the Choose Music menu, select the music track. 
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Managing Photo Album Music in Website Builder 
  

Warning: This information applies to Website Builder accounts purchased after Oct. 26, 2010.  

With Website Builder, you can add music files to slideshows and montages. From the Audio 
Files screen in Website Builder, you can also delete files, edit their titles, and play files to make 
sure they complement your images. 

Use the steps below to upload and edit music files in your photo album. Once you've uploaded 
music files, see Adding Music to Your Photo Slideshow for information about adding music to a 
slideshow. 

 

Uploading Music 
 

You can upload music to complement your photo slideshows and montages. 

To Upload Music 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. From the Photos and Videos tab, click Upload. 

4. From Step 1: Select file type, select Audio. 

5. From Step 2: Select and upload your audio, click Browse. 

6. Select the music file you want to upload, and then click Open. Repeat as necessary. 

7. From Step 2: Select and upload your audio, click Upload. 

8. The file is added to your account. 
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Editing Music 
 

You can edit the titles of your music files. 

To Edit Music 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. From the Photos and Videos tab, go to the Tools menu, and then select Manage Music. 

4. Select the file you want to edit, and then click Edit. 

5. Enter a new title in the Title field, and then click Save. 

 

Deleting Music 
 

You can delete the music files you no longer want. 

To Delete Music 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. From the Photos and Videos tab, go to the Tools menu, and then select Manage Music. 

4. Select the file you want to delete, and then click Delete. 

5. Click Save. The file deletes from your account. 

Note: You can restore deleted music files from the Recycle Bin until you select them, and 
then click Restore Selected Items, or click Empty Recycle Bin. Once you do, the files are 
permanently deleted. 
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Restoring Music 
 

You can restore music files once you delete them. 

To Restore Music 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Go to the Photos and Videos tab, and then click Recycle Bin. 

4. Select the files you want to restore, and then click Restore Selected Items. 

Note: You can restore deleted music files from the Recycle Bin until you select them, and 
then click Restore Selected Items, or click Empty Recycle Bin. Once you do, the files are 
permanently deleted. 

 

Playing Music 
 

You can play music files to make sure they complement your images. 

To Play Music 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. From the Photos and Videos tab, go to the Tools menu, and then select Manage Music. 

4. Select the file you want to play, and then click Play. The file plays. 
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Downloading Multiple Photos 
 

Using Website Builder you can download multiple files you might have previously uploaded to 
the application. 

To Download Multiple Photos from Website Builder 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Photos and Videos, and then select the gallery you wish to download photos from. 

5. Click Manage Photos. 

6. Place check marks by the photos that you wish to download. 

7. From the Apply this action drop-down box, select Download Photos. 

Note: The photos you have selected will download as a single ZIP file. After the download is 
complete, unzip the file to access your photos. 

 

 

Cropping Photos 
 

You can crop photos in Website Builder by specifying the width-to-height ratio you want to 
maintain, and then selecting the portion of the photo you want to keep. When you crop the 
photo, only the portion you selected remains. 

You can also edit photos by rotating or flipping the image. For more information, see Rotating 
and Flipping Photos. 

Website Builder keeps an original version of all your edited photos. You can restore the original 
photo at any time. For more information, see Restoring Edited Photos. 

To Crop Photos in Website Builder 

1. Log in to your Account Manager. 

2. Click Website Builder. 



Website Builder 6 Help Guide                                                                                                            67 
 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Photos and Videos, and then click the name of the gallery you want to view. 

5. Click Edit Photo above the photo you want to modify. 

6. Select the Crop tab. 

7. From the Orientation area, select whether you want to maintain the size ratio in 
landscape or portrait format. 

8. From the Size area, select an option for maintaining the width-to-height ratio of the 
photo. 

9. Holding down the mouse button, drag diagonally to select the portion of the photo you 
want to keep. When you crop the photo, this portion will be the only part of the photo 
remaining. 

Note: Once you have created the area to be cropped, you can resize the are or move the 
entire selected area. 

10. Click the Crop button. 

 Note: If you need to start over at any time, click the Reset. 

11. Click Save. 

If you edit a photo without saving, the next time you try to edit a photo, Website Builder lets you 
resume the editing session for the unsaved photo. 

 

 

Rotating and Flipping Photos 
 

Using Website Builder you can rotate photos left or right or flip them vertically or horizontally. 
You can also edit photos by cropping them. For more information, see Cropping Photos. 

Website Builder keeps an original version of all your edited photos. You can restore the original 
photo at any time. For more information, see Restoring Edited Photos. 

1. Log in to your Account Manager. 

2. Click Website Builder. 
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3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Photos and Videos, and then click the name of the gallery you want to view. 

5. Click Edit Photo above the photo you want to modify. 

6. To rotate or flip the photo, click one of the following: 

Rotate Left 

Rotates the photo 90 degrees to the left (counterclockwise). 

Rotate Right 

Rotates the photo 90 degrees to the right (clockwise). 

Flip Horizontal 

Flips the photo horizontally (sideways). 

Flip Vertical 

Flips the photo vertically (up and down). 

Note: If you need to start over at any time, click Reset. 

7. Click Save. 

If you edit a photo without saving, the next time you try to edit a photo, Website Builder lets you 
resume the editing session for the unsaved photo. 

 

Restoring Edited Photos 
 

Website Builder keeps an original version of all your edited photos. You can restore the original 
photo at any time. For more information about editing photos, see Cropping Photos or Rotating 
and Flipping Photos. 

To Restore Edited Photos in Website Builder 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 
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4. From Gallery, click Photos and Videos, and then click the name of the gallery you want 
to view. 

5. Click Edit above the photo you want to modify. 

6. Click Restore Original. 

Note: Restore Original only displays for photos you edited. 

7. Click Save. 

 

 

Editing Image Galleries 
 

You can change the order of your images, add or remove images, or change display styles for 
your image galleries in Website Builder v6. 

 
Re-Ordering Image Galleries 
 

You can change the order in which your images display. 

To Re-Order Image Galleries 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page that you want to modify. 

5. Click the image gallery content box, and then do one of the following: 

o If you selected Individual for your image source when you created your image 
gallery: 

1. Double-click the image gallery. 

2. Click Step 1. Select Images. 
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3. Using the up/down arrows on the left, drag the file to where you want it 
placed. 

4. Click OK. 

o If you selected Gallery for your image source when you created your image gallery: 

1. Click Exit Designer. 

2. Click the Photos and Videos tab. 

3. Click the thumbnail of the gallery you want to edit, and then 
click Manage. 

4. Click Organize, and then drag the images in the order that you want. 

5. Click Save. 

6. If you want to continue editing your website, click the Site tab. 

 

Adding Images to Image Galleries 
 

Once you create image galleries, you can add more images to them. 

To Add Images to Image Galleries 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page that you want to modify. 

5. Click the image gallery content box, and then do one of the following: 

o If you selected Individual for your image source when you created your image 
gallery: 

1. Double-click the image gallery. 

2. Click Step 1. Select Images. 

3. Click Add Images. 

4. Click the images you want to add. 
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5. Click OK, and then click OK. 

o If you selected Gallery for your image source when you created your image gallery: 

1. Click Exit Designer. 

2. Click the Photos and Videos tab. 

3. Click the thumbnail of the gallery you want to edit, and then click Upload. 

4. Select Photos and videos for your file type. 

5. Select the gallery you want to add images to, and then click Browse. 

6. Select the image you want to upload, and then click Open. 

7. Click Upload, and then wait for your upload to complete. 

8. If you want to continue editing your website, click the Site tab. 

 

Removing Images from Image Galleries 
 

Once you create image galleries, you can remove images from them. 

To Remove Images from Image Galleries 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page that you want to modify. 

5. Click the image gallery content box, and then do one of the following: 

o If you selected Individual for your image source when you created your image 
gallery: 

1. Double-click the image gallery. 

2. Click Step 1. Select Images. 

3. Click Delete next to the image. 

Note: The image is permanently removed and cannot be restored once you 
click OK. If you don't want to delete an image, click the restore icon. 



Website Builder 6 Help Guide                                                                                                            72 
 

4. Click OK. 

o If you selected Gallery for your image source when you created your image gallery: 

1. Click Exit Designer. 

2. Click the Photos and Videos tab. 

3. Click the thumbnail of the gallery you want to edit, and then 
click Manage. 

4. Select the images you want to remove, and then from the Apply this 
action menu, select Delete Items. 

5. Click Go, and then click Yes to confirm deletion. 

6. If you want to continue editing your website, click the Site tab. 

 

Managing Image Gallery Settings 
 

Once you create image galleries, you can manage their settings. 

To Manage Image Gallery Settings 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page that you want to modify. 

5. Click the image gallery content box, and then double-click the image gallery. 

6. Click Step 2. Settings. 

7. Click the display style you want: 

o Thumbnail — Displays the images as thumbnails. If you click on a thumbnail, the 
image slideshow displays. 

• Show image titles — Displays the name of the image. 

• Columns and Rows — Determine the height, width, and image size of the 
image gallery. For the largest images, choose 1 as the column setting. 
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Navigation for additional images displays if selected column/row settings are 
not sufficient to show all images. 

• Image resizing — Specifies the shapes of images after cropping. 

o Slideshow — Displays images in a slideshow. Use the control bar to stop, play, or 
view the previous or next image in the slideshow. You can also adjust the speed of 
the slideshow using the slider. 

• Show image titles — Displays the name of the image. 
• Control bar location — Determines where the control bar is displayed on the 

slideshow. Uncheck Display control bar to disable the control bar. 
o Animated slideshow — Displays images in an animated slideshow. Use the settings 

to determine how the slideshow is displayed. 
• Image size — Determines the size of the images displayed in the slideshow. 
• Slide speed — Determines the image rotation speed of the slideshow. 
• Effects — Determines the animation effect during image transition. 
• Show image titles — Displays the name of the image. 
• Control bar location — Determines where the control bar is displayed on the 

slideshow. Uncheck Display control bar to disable the control bar. 
• Thumbnail strip and Thumbnail size — Determines the thumbnail strip 

location on the slideshow, and the size of the thumbnail images. 
o Lightbox — Displays images through a JavaScript application used to magnify 

image galleries in windows on top of webpages. 
• Image size — Determines the size of the images displayed in Lightbox. 
• Show image titles — Displays the name of the image. 

8. Click OK. 
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Organizing Gallery Items 
 

In Website Builder, you can change the order in which your media displays in galleries, move 
them to other galleries, tag them with keywords or phrases, or delete them. To rearrange 
media, you must sort them alphabetically, by date, or drag them to a new location on the 
Organize page. 

To Rearrange Media 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Go to Photos and Videos, and then click the gallery that contains the media you want to 
move. 

5. Click Manage. 

6. Click Organize. 

7. Drag the media you want to the new location in the gallery or Apply an action from 
the Organize by list. 

8. Click Save. 

 Note: You can click Cancel to restore the photos to their original order for this session. 
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Editing Photo Galleries 
 

In Website Builder, you can edit your photo gallery's settings and theme. Settings include the 
gallery's title and how you display it. The theme is a combination of complementary colors. 

For more information about changing gallery themes, see Setting Photo Gallery Themes. 
For more information about completing these fields, see Creating Galleries. 

To Edit Your Photo Gallery's Settings 

1. Log in to your Website Builder account. 

2. Click the Photos and Videos tab. 

3. Click Edit Galleries. 

4. Click the name of the gallery you want to edit. 

5. From the General tab, edit the following information: 

o Gallery name — Enter a name to display for the gallery. 
o Gallery description — Enter a description to display for the gallery. 
o Display number of gallery items — Select to display the number of items in your 

gallery. 
o Date display — Select to display the date you created the gallery, the date you last 

updated your gallery, no date, or select and then enter a custom date. 
o Privacy settings — Select Public to make your gallery viewable by anyone, Private to 

make it viewable only by you, or Password protected to make it viewable only by 
those who have the password you specify. 

6. From the Gallery Theme tab, select a category and color. 

7. Click Save. Your gallery is edited. 
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Setting Photo Gallery Themes 
 

In Website Builder you can select a theme to establish the look and feel of your photo album. 
You can also set themes for individual galleries. 

To narrow the list of themes that display, you can filter the list by category and color. Website 
Builder displays the five themes that most closely match the criteria you sorted by. 

To Set Photo Gallery Themes in Website Builder 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Photos and Videos, and then click Settings. 

5. Select the Default Theme tab. 

6. Filter the list of themes you want to view by selecting an option from one or both of the 
following lists: 

o Category — View all themes associated with a specific category. 
o Color — View all themes associated with a specific color. 

7. Click the theme you want to use. 

8. Click Save. 

Note: You can preview the theme by clicking Preview Theme. 
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Moving Media Between Galleries 
 

You can move all media from an entire gallery in Website Builder to another gallery, or you can 
select the individual files you want to move and specify the gallery you want to move them to. 

 

To Move Media from an Entire Gallery to Another Gallery 
 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Photos and Videos, and then click Edit Galleries. 

5. Select the gallery or galleries you want to move media from. 

6. From the Apply this action list, select Move Media. 

7. Click Go. 

8. From the Move Media to list, select the gallery to which you want to move the media to. 

9. Click Move Media. 

 

To Select Individual File to Move Between Galleries 
 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Photos and Videos, and then click View Galleries. 

5. Click the gallery that contains the media you want to move. 

6. Click Manage. 

7. Select the photos or videos. 
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8. From the Apply this action list, select Move Items. 

9. Click Go. 

10. From the Move selected items to list, select the gallery where you want to add the 
media. 

11. Click Move Items. 

 

 

Viewing Galleries 
 

You can add multiple photo galleries to your Website Builder project. When viewing your photo 
galleries, you can switch between them from the Gallery tab. 

To Switch Between Photo Galleries in Website Builder 

1. Log in to your account. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Photos and Videos, and then click Home. The gallery view displays with a list of 
your galleries on the Gallery tab. 

Note: If you are already logged into your account, you can click Home any time to bring 
up the gallery view. 

5. Click the name of the gallery you want to view. 
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Making Photo Galleries Private 
 

You can make your Website Builder galleries private so that visitors won't be able to see them 
on your website. In this way, only you have access to these galleries. You can also password-
protect galleries so that visitors can view them only if they have the password. For more 
information about password-protecting galleries, see Password-Protecting Photo Galleries. 

To Make Photo Galleries Private in Website Builder 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Photos and Videos. 

5. From the galleries menu, click Edit Galleries. 

6. Click the Edit hyperlink for the gallery you want to edit, where the gallery name is the 
name of the gallery you selected. The hyperlink displays next to the Thumbnails tab. 

7. From the Privacy settings area, select Private. 

8. Click Save. 
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Sharing Photos, Videos, and Galleries 
 

Once you've published your Photo Album, Website Builder creates hyperlinks to your public 
galleries and photos and videos. These hyperlinks remain valid as long as your Photo Album is 
published. 

You can create hyperlinks to galleries, individual photos, and videos, and to all photos 
associated with a tag. You can share these hyperlinks with friends and family so they can view 
your photos and videos as often as they want. 

Note: Your galleries must be published for you to share. 

 

Publishing Your Photo Album 
 

You can publish your Photo Album and share hyperlinks to your public galleries and photos and 
videos. 

To Publish Your Photo Album 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click the Photos and Videos tab. 

4. Click Publish Gallery Site, and then click Yes. 

Note: The Publish Gallery Site option only displays if your galleries were never published. 
To verify your galleries are published, go to the Settings tab, click Photos and Videos 
Settings, select Publish my galleries as a website, and then click Save. 

You can now share hyperlinks to your galleries, photos and videos. 
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Sharing Your Galleries 
 

You can share a hyperlink to let others view a gallery you created in your Photo Album. 

To Share Your Galley 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click the Photos and Videos tab. 

4. Click the thumbnail of the gallery you want to share. 

5. Click the Thumbnail button. 

6. Click Share. 

7. Select the style of hyperlink you want. 

8. Copy the URL. You can now paste the URL in an email, add it to a Web page, or send it 
in a message. 

 

Sharing Your Photos or Videos 
 

You can share a hyperlink to let others view a photo or video you uploaded to your Photo 
Album. 

To Share Your Photo or Video 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click the Photos and Videos tab. 

4. Click the thumbnail of the gallery that contains the photo you want to share. 

5. Click the Filmstrip button. 

6. Click the Share button. 

7. Select either Link to item or Link to site. 
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8. Select the image size to display. 

9. Select the style of hyperlink you want. 

10. Copy the URL. You can now paste the URL in an email, add it to a Web page, or send it 
in a message. 

 

Sharing Tagged Photos 
 

You can share a hyperlink to let others view all the photos you've associated with a tag in your 
Photo Album. 

To Share Tagged Photos 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click the Photos and Videos tab. 

4. Click the thumbnail of the gallery that contains the tagged photo you want to share. 

5. Click the name of the tag you want to share. 

6. Click the Share button. 

7. Select the style of hyperlink you want. 

8. Copy the URL. You can now paste the URL in an email, add it to a Web page, or send it 
in a message. 
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Playing Videos in Photo Album Slideshow 
 

If you added videos to your Website Builder slideshow, they play automatically as the slideshow 
rotates through the pictures and videos. If you set music to your slideshow, it fades during a 
video, but continues playing in the background. 

You can control the music's volume using the volume control. The background music returns to 
regular volume when the video is complete. 

The slideshow resumes rotation after the video completes. If you pause the video, the slideshow 
is paused. The slideshow does not continue until the video completes. Pausing the slideshow, 
pauses the video, too. 

 

 

Sharing Permanent Links to Photos and Videos with Social 
Network Sites 
 

Website Builder lets you share permanent links to your photo galleries, photos, and videos, 
which are valid as long as they are uploaded to your Website Builder account. 

You can also share your permanent links with your social networks. Post it on Facebook® or 
MySpace®, tweet it on Twitter®, save it to Delicious® or share it via RSS feed. 

To Share a Permanent Link to A Social Network Site 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Photos and Videos, and then click the gallery you want to share. 

5. Click the Filmstrip button. 

6. Click the Share button. 

7. Select between Link to item or Link to site. 
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8. From the second drop-down menu, select the type of hyperlink to display. 

9. Click the icon of the social networking site you want to share your link with. 

10. Follow login instructions for the site until the process completes and your link is visible. 

 

 

Managing Photo Album Settings 
 

Manage your album settings when you launch Website Builder for the first time. You can edit 
the settings at any time. 

To Manage Album Settings in Website Builder 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click the Photos and Videos tab. 

4. From the Settings menu, select Photos and Videos Settings. 

5. From the Photos and Videos Settings tab, enter the following information: 

o Site title — The title of your site. 
o Site visibility — Select to publish your galleries as a website, letting you share 

hyperlinks to photos and videos. For more information, see Sharing Photos, Videos, 
and Galleries. 

o Default Media View — Specify whether you want your view to default to the 
Thumbnail, Filmstrip, Slideshow, or List tab. 

o Thumbnail View — Select the number of photos you want to display. 
o Gallery View — Select the number of galleries you want to display. 
o Gallery Description — Select to show gallery descriptions on home page. 
o Photo downloads — Select to prevent visitors from right-clicking to save photos. 
o Like feature — Select to display a button letting visitors like galleries and individual 

photos. 
o Display Information — Select Text, URL, or Email, and then enter the corresponding 

information to display text, a URL or an email address with your galleries. 
o Embedding — Select to allow visitors to enable embedding of your montages. 

6. From the Gallery Theme tab, select a category and color. 
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7. From the Upload via Email tab, enter the following information: 

o Upload through email — Select to enable email uploading. 
o Email address — Note the address. This is where you email photos to upload them. 
o Enter security code — Enter a security code to use when you upload through email. 
o Default gallery — Select a default gallery for photos you upload through email. 
o Default tags — (optional) Enter default tags to apply to photos you upload through 

email. 

8. From the Blog Settings tab, perform the following actions: 

o Click Add Blog to display your Photo Album content on your blog. 
o Select an available blog from your account, or enter the URL to a blog you registered 

elsewhere. 
o In the Blog User Name field, enter the user name for the blog you're adding. 
o In the Blog Password field, enter the your password for the blog you're adding. 

9. Click Save. Your settings are updated. 

 

 

Changing Your Photos and Videos Domain 
 

Set your domain information when you launch Website Builder for the first time. You can edit 
the domain at any time. 

To Change Your Photos and Videos Domain in Website Builder 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Photos and Videos, and then click Settings. 

5. Select the Domain Settings tab. 

6. Click Edit to edit your domain. 
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7. From the Domain Settings area, select one of the following: 

o Create a new subdomain — Add a subdomain and select the site for which you want 
to use the subdomain. 

o Select an available domain from your account — Select from a list of domains 
associated with your account. 

o Enter a domain not registered here — Enter a domain name that you registered at a 
different account. 

Note: If you enter a domain that you registered with another registrar, please update the 
"A Record" for your domain so it points to the IP address 208.109.80.29. For more 
information, contact your domain registrar. 

8. Click Save. 

 

 

Password-Protecting Photo Galleries 
 

You can password-protect Website Builder galleries so that visitors can only view them if they 
have the password. 

Note: If you use the same password for multiple galleries, visitors can access all galleries 
that use that password. 

You can also make your galleries private so that they're only accessible to you, and visitors 
won't be able to see them on your website. For more information about making a gallery 
private, see Making Photo Galleries Private. 

To Password-Protect a Photo Gallery 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Photos and Videos, and then click the name of the gallery you want to password-
protect. 
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5. Mouse over the Edit hyperlink for the gallery you want to edit, where the gallery name is 
the name of the gallery you selected. The hyperlink is located next to the Thumbnails 
tab. 

6. From the Privacy settings area, select Password-Protected. 

7. In the Enter Password field, enter the password. 

8. Click Save. 

 

 

Subscribing to your Website and Gallery 
 

Using RSS, anyone can subscribe to your Website Builder site and photo galleries to receive 
updated content. 

RSS is a Web content syndication format that you can use to subscribe to websites, such as 
news sites and blogs. Subscription content is updated in real time, so when someone updates a 
website you've subscribed to, the update displays in your RSS reader. Depending on the RSS 
reader you use, new content either displays in its entirety or in a condensed version of the entry. 

To Subscribe to your Website and Gallery in Website Builder 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Photos and Videos, and then click Home. 

5. Go to the name of the gallery to which you want to subscribe, click Share and then click 
the RSS Feed icon. 

6. Click the Subscribe to hyperlink, where is the name of your gallery. 
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Creating Photo Montages 
 
Website Builder lets you create montages, and then display them on your Web pages. 
Montages are series of images set to music or visual effects. To create montages, use photos in 
your image galleries. 

You can arrange photos in any sequence, select transitions between photos, and even add 
music. You can also share permanent links to your montages or embed them directly into your 
website. 

Once you create montages, you can edit them or delete those you no longer use. 

Note: Photos you add to your montage must be from public galleries. You can't create 
montages using photos from private or password-protected galleries. 

1. Log in to your Website Builder account. 

2. Click the Photos and Videos tab. 

3. If you haven't created a gallery, click Create Gallery, and then complete the appropriate 
steps. 

4. From the Montages box in the sidebar, click Create Montage. 

5. In the Title field, enter a title for your montage, and then click Create. 

6. From the Gallery menu, select the gallery that contains images you want to use. 

7. To add photos, do one of the following: 

o Click Select all loaded images to add all of the photos in the gallery. 
o Drag the photo you want to add to the timeline. 

8. Click Save. 

 

To Edit Montages 
 

1. Log in to your Website Builder account. 

2. Click the Photos and Videos tab. 

3. From the Montages box in the sidebar, click the montage you want to edit. 

4. From the Gallery menu, select the gallery you want to edit. 
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5. To add photos, do one of the following: 

o Click Select all loaded images to add all of the photos within the selected gallery. 
o Click and drag the photo you want to add to the timeline. 

6. To delete photos, do one of the following: 

o From the timeline, go to the photo you want to delete, and then click the Remove 
Image icon. 

o Click Clear all photos. 

7. To edit how montages transition between images, do the following: 

o From the timeline, select the photo you want to change, and then click the Change 
transition icon. 

o From the Transition menu, select the photo transition you want to use, and then 
click Save. 

8. To edit the montage title, do the following: 

o Click the Options tab. 
o Enter a new title in the Title field, and then click Save. 

9. To edit the montage speed and background color, do the following: 

o Click the Options tab, and then from the Speed menu, select the speed of photo 
transitions. 

o From the Background color section, select a background color for your montage. 

10. Click Save. 

 

To Delete Montages 
 

1. Log in to your Website Builder account. 

2. Click the Photos and Videos tab. 

3. From the Montages box in the sidebar, click the montage you want to delete. 

4. Click the Options tab, click Delete This Montage, and then click OK. 
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To Add Music to Montages 
 

1. Log in to your Website Builder account. 

2. Click the Photos and Videos tab. 

3. From the Montages box in the sidebar, click the montage where you want to add music. 

4. Click the Options tab, and then from the Music menu, select the music you want to use. 

5. Click Save. 

 

To Share Montages 
 

1. Log in to your Website Builder account. 

2. Click the Photos and Videos tab. 

3. From the Montages box in the sidebar, click the montage you want to share. 

4. Click the Options tab, and then click Share this montage. 

5. Copy the Link to URL to share the permanent link for your montage with others. 

6. To embed your montage in another website, copy the Embed code. 

Note: You must publish your gallery to make the Link to URL active.  

 

To Embed Montages 
 

1. Log in to your Website Builder account. 

2. Click Design Your Pages. 

3. If necessary, from the Current Page menu, select the page that you want to modify. 

4. Click Media, and then drag and drop the Montage icon over a Drop Zone. Drop Zones 
display on your Web pages when you hover over them. 
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5. From the Select an account menu, select the account you want to use. 

6. From the Select montage menu, select the montage you want to embed. 

Note: To create or edit montages, from the Select Montage menu, select Create 
Montage or Edit Montage.  

7. For the montage to play when visitors reach your Web pages, from the Settings section, 
select Autostart montage. 

8. Click OK. 

 

 

Converting BMP files to JPG files 
 

Using Website Builder you can convert your BMP files to JPG files. Converting your BMP images 
to JPG lets you to display your photos online or use them in a Flash® slideshow. 

To Convert BMP Files to JPG Files in Website Builder 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Photos and Videos. 

5. From the Tools menu, select Convert Bitmaps. 

Note: If you do not have any photos in need of conversion, no list displays. 

6. Select photos individually, or click All. 

7. Click Convert to jpeg. 

8. To return to the main page, click Home. 
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Changing Photo Brightness 
 

You can enhance or decrease photo lighting by changing the brightness. When you select to 
change the photo's brightness, Website Builder creates several thumbnails with different 
brightness levels applied to them. Select the thumbnail you want to use and apply the change. 

To Change the Brightness in Photos in Website Builder 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Photos and Videos, and then click the the gallery you want to view. 

5. Click Edit above the photo you want to modify. 

6. Click Decrease Brightness or Increase Brightness. 

7. Select the photo you want to use, and then click Apply. 

8. Click Save. 

 

 

Changing Contrast in Photos 
 

You can enhance or decrease photo details by changing the contrast. When you select to 
change the photo's contrast, Website Builder creates several thumbnails with different contrast 
levels applied to them. Select the thumbnail you want to use and apply the change. 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Photos and Videos, and then click the gallery you want to view. 
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5. Click Edit above the photo you want to modify. 

6. Click Decrease Contrast or Increase Contrast. 

7. Select the photo you want to use, and then click Apply. 

8. Click Save. 

 

 

Removing Red-eye in Photos 
 

You can use the red-eye tool in Website Builder to remove the appearance of red or glowing 
eyes from photos. 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Photos and Videos, and then click the name of the gallery you want to view. 

5. Click Edit Photo above the photo you want to modify. 

6. From the Edit area, click Remove Red Eye. 

7. Select the portion of the photo that contains the red eye. 

8. Click Remove Red-eye. 

9. Click Save. 
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Working with Photo Badges 
 

With Website Builder, you can create photo badges using HTML or Flash® and share them. A 
photo badge is a single photo or group of photos that you can share with other websites, such 
as your blog, Facebook®, or MySpace®. 

You can create a photo badge from public photos on your website or gallery, and save the 
badges you create. You also can customize the badge's layout, color and other features. 

Note: Photo badges use the first photos in your gallery. You can change the photos that display 
in your badge by reorganizing the order in which they display in your gallery. For more 
information, see Organizing Gallery Items. 

 

Creating a Photo Badge of an Individual Photo 
 

With Website Builder you can create photo badges using images from your photo galleries. 

 

To Create a Photo Badge of an Individual Photo 

 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. Next to the account you want to use, click Manage. 

4. Click Photos and Videos. 

5. From the Tools menu, select Create Badge. 

6. On the Select a Badge page, select HTML Single Image badge, and then click Next. 

7. On the Select Photos page, select one of the following: 

o Public photos from your gallery — Use a public photo from a specific gallery. 

o Public photos tagged with — Use a public photo that has a specific tag. 

8. Click Next. 
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9. On the Set Layout page, select the following: 

o Display title — Specify whether you want the site title to display on the badge. 

o Photo size — Select the size of the photo to display on the badge. 

o Link Target — Choose Thumbnail, Filmstip or Slideshow View. 

10. Click Next. 

11. On the Select Background Color page, select a color from the palette or enter a color 
value, and then click Finish. 

12. From the Here is the code area, select and copy the code, and then paste it into the 
code on your Web page. 

13. To save the badge, in the Badge name field, enter the name, and then click Save. 

 

Creating a Photo Badge of Multiple Photos 
 

Using Website Builder, you can create photo badges that consist of multiple images from your 
photo galleries. 

 

To Create a Photo Badge of Multiple Photos 

 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Photos and Videos. 

5. From the Tools menu, select Create Badge. 

6. On the Select a Badge page, select HTML Gallery Badge, and then click Next. 

7. On the Select Photos page, select from one of the following: 

o Public Photos from your gallery — Use public photos from a specific gallery. 

o Public photos tagged with — Use public photos that have a specific tag. 
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8. Click Next. 

9. On the Set Layout tab, select the following: 

o Display title — Specify whether you want the site title to display on the badge. 

o Number of photos to display — Select the number of photos you want to display 
on the badge. 

o Arrange photos by — Determine the order in which photos display on the badge. 

o Turn paging on — Specify whether visitors can advance through the entire 
gallery or only view the number of photos you select. 

10. Click Next. 

11. On the Select Background Color page, select the color from the palette or enter the 
color values, and then click Finish. 

12. From the Here is the code area, select and copy the code, and then paste it into the 
code on your Web page. 

13. To save the badge, in the Badge name field, enter the name, and then click Save. 

 

Creating a Flash Photo Badge 
 

With Website Builder you can create Flash photo badges using images from your photo 
galleries. 

 

To Create a Flash Photo Badge 

 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. Next to the account you want to use, click Manage. 

4. Click Photos and Videos. 

5. From the Tools menu, select Create Badge. 

6. On the Select a Badge page, select Flash Gallery badge, and then click Next. 
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7. On the Select Photos page, select one of the following: 

o Public photos from your gallery — Use a public photo from a specific gallery. 

o Public photos tagged with — Use a public photo that has a specific tag. 

8. Click Next. 

9. On the Set Layout page, select the following: 

o Display title — Specify whether you want the site title to display on the badge. 

o Number of photos to display — Select the number of photos you want to display 
on the badge. 

o Shuffle Speed — Set the frequency with which the photos cycle. 

10. Click Next. 

11. On the Select Background Color page, select a color from the palette or enter a color 
value, and then click Finish. 

12. From the Here is the code area, select and copy the code, and then paste it into the 
code on your Web page. 

13. To save the badge, in the Badge name field, enter the name, and then click Save. 

 

Viewing Saved Badges 
 

After you create a badge, you can view your saved badges in Website Builder. 

 

To View Saved Badges 

 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Photos and Videos, and then click Tools. 

5. Click Manage Badges. 
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Displaying Code for Saved Badges 
 

After you create a badge, Website Builder displays HTML code you can copy and paste into 
Web pages. 

 

To Display Code for Saved Badges 

 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Photos and Videos, and then click Tools. 

5. Click Manage Badges. 

6. Click Get Code. 

 

Deleting Your Saved Badges 
 

If you no longer want to keep a badge saved in your photos and videos settings, you can delete 
it. 

 

To Delete Your Saved Badges 

 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Photos and Videos, and then click Tools. 
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5. Click Manage Badges. 

6. Click Delete next to the badge you want to delete. 

7. Click OK to confirm you want to delete the badge. 

 

 

Emailing Photos 
 

You can use Website Builder to email photos to your friends and family. When you share photos 
you added to public galleries, your emails display links back to those galleries. If you share 
photos from private or password-protected, no links display. 

 

To Email Photos in Website Builder 

 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Photos and Videos, and then click the gallery that contains the photo you want to 
send. 

5. From the Settings tab, select Photos and Video Settings. 

6. Select Publish my galleries as a website, and then click Save. 

7. Click Photos and Videos, and then click the gallery that contains the photo you want to 
send. 

8. Click the photo you want to send. 

9. Click Email. 

10. Enter the following information: 

o To — Enter your email address and the address(es) to which you want to send the 
photo. 

o From — Enter your name. 
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o Subject — Enter the subject of the email message. 
o Message — Enter the message body. 
o Enter code shown above — Enter the security access code that displays above the 

field. 

11. Click Send Email. 

 

 

Sharing your Photos with Blogs 
 

Using Website Builder, you can share your saved photos to your blog. 

 

To Share your Website Builder Photos with Blogs 

 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Photos and Videos. 

5. Click the image you want to share, and then click Blog. 

6. Enter the photo settings in the following fields: 

o Blog — Select the blog you want to post the photo in. See Adding a Blog URL to your 
Blog Photo List for more information. 

o Category — (Optional) Enter a category for this blog entry. You can enter multiple 
categories separating each one by a comma. 

o Title — Enter a title for this blog entry. 
o Message — (Optional) Enter a message to post with this photo in the blog entry. 
o Choose Layout Template — Select a layout template for how you would like your 

photo and message to display in the blog. 
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7. Click Blog This Photo. 

Note: By default, only the primary author can use the remote blogging feature. However, 
additional authors can use this feature if the "Can write new entries?" permission is set in 
their profiles. 

For assistance editing or deleting a blog in your list, see Editing and Deleting Photo Blog 
Settings. 

For assistance blogging images from protected galleries, see Blogging Photos from Private or 
Password Protected Galleries. 

 

 

Editing and Deleting Photo Blog Settings 
 

In your Website Builder account, you can edit blog settings added to your Blog Photo list. You 
can update a blog address, user name, and password information. You can also delete a blog 
from the list. 

 

To Edit Blog Settings in Website Builder 
 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Photos and Videos, and then click Settings. 

5. Click the Blog Settings tab. 

6. Click the Edit (pencil) icon next to the blog address you want to modify. 

7. Update any information you want to change. 

8. Click OK. 
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To Delete Blog Settings in Website Builder 
 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Photos and Videos, and then click Settings. 

5. Click the Blog Settings tab. 

6. Click Delete next to the blog address you want to modify. 

7. Click OK. 

For assistance sending photo blog entries to your blog, see Sharing your Photos with Blogs. 

 

 

Adding a Blog URL to your Blog Photo List 
 

You can send images from your Website Builder accounts directly to your blog. However, you're 
not limited to just one blog; you can add multiple blogs to your Blog Photo list, so you can easily 
select a specific blog to send a specific image as an entry. 

To Add a Blog URL to your Blog Photo List in Website Builder 

1. Log in to your Account Manager. 

2. Click Website Builder. 

3. In your Website Builder Account list, click Manage next to the account you want to 
modify. 

4. Click Photos and Videos, and then click Settings. 

5. Click the Blog Settings tab. 

6. Click Add Blog. 

7. Enter the required blog information: 
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o Blog URL — Enter the full URL of your blog. For 
example, http://blog.coolexample.com. To use the Blog Photo feature, your blog 
must support the MetaWeblog API and RSD. 

o Blog User Name — Enter the user name you use to manage your blog. 
o Blog Password — Enter the password you use to manage your blog. 

8. (Optional) Click Send a test post. This step sends a test post to your blog to validate the 
settings you've entered. You can delete it once it displays in your blog. 

9. Click Save. 

 

 

Blogging Photos from Private or Password Protected Galleries 
 

You can send images from your Website Builder account directly to your blog using the Blog 
Image feature. However, access to the image may be limited depending on the privacy level you 
set for the gallery in which the image is stored. There are three privacy levels for Website 
Builder Galleries: 

• Public — This setting makes the gallery available for public view. 

• Private — This setting makes the gallery private so only you, the owner, can view it 
when logged in to the website. 

• Password Protected — This setting makes the gallery accessible only to visitors who 
enter the correct password. You can blog photos from galleries that you have marked 
Password Protected. However, when people click a password-protected photo displayed 
on your blog, they're not able to access it without knowing the password. 

Note: If you share a picture stored in a Public gallery and later change the gallery to Private 
or Password Protected, you must manually remove the image from your blog, since the blog 
software has no way of knowing that you have changed the gallery status. 

For assistance sending photo blog entries to your blog, see Sharing your Photos with Blogs. 
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Adding a Favicon to Your Website Builder Site 
 

Website Builder version 6 gives you the option of adding a favicon to your site. 

A favicon (or favorites icon) is an icon that is associated with a particular Web page or site. 
When a visitor bookmarks your site, the favicon will display next to the name of your Web page 
in their favorites list. 

In many browsers, your favicon will display before the URL in the address bar. This helps a site 
stand out in a list of favorites and creates a customized appearance in the visitor's browser. 
Favicons are a popular way to draw attention to, and promote a website. Favicons are often 
corporate logos or images. 

Note: Your favicon must be 16x16 pixels in size. Favicons must be rendered as .ico files 
to function properly in Internet Explorer. Other browsers support .jpg, .gif. and .png 
files. 

To Add a Favicon to Your Site 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. If you are working in the Page Designer, click Exit Designer. 

4. From the Settings menu, select Configuration. 

5. In the Favicon area, click Browse. 

6. Select the favicon image you want upload. 

7. Click OK. 
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Adding and deactivating a Guest Book 
 

You can add a guest book so visitors can leave comments on your website. You can set guest 
book entries to require approval or display immediately, and modify your guest book colors to 
compliment the look and feel of your website. 

You can deactivate your guest book or replace it anytime. 

Note: When you add a guest book to your website, it counts against the number of pages 
your Website Builder plan allows. For example, if your Website Builder plan includes 10 
pages, when you add a guest book to your site, you have 9 remaining pages to use when 
building your website. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Add-Ons, and then select Guest Book. 

4. In the Email Address field, enter the email address you want to use to send comments 
and receive notifications. 

5. Click Setup Guest Book. 

6. To edit your guest book settings, click the the Guest Book preview, hover your mouse 
over the gear icon, and then select Edit Guest Book. From the Settings tab, edit the 
following information: 

o Guest Book Name — Enter a name for your guest book to display online. 
o Email Address — Enter an email address to receive notifications. 
o Approval Types for New Comments — Select Manual to manually approve 

comments, Automatic to let visitors post comments without approval, and Send 
email notification when a new comment is added to receive email message when 
there are comments awaiting approval. 

o Number of Entries Per Page — Enter the maximum number of comments to display 
online. 

o Profanity Filter — Select Use profanity filter to activate the profanity filter, and then 
enter the profane words you want to filter or click Use Default List to enter a list of 
common profanity. In the Replace with field, enter a term to replace profanity, such 
as "****" 
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7. Click Apply. 

8. From the Display tab, select colors for the design elements of your guest book. 

9. Click OK, and click Publish. The guest book displays on your Web page. 

 

To Deactivate a Guest Book in Website Builder 

 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Add-Ons, and then select Guest Book. 

4. Click the Settings tab, select Deactivate Guest Book, and click OK. 

5. Click Publish; the guest book will longer display on your website. 

 

 

Access my guest book or calendar 
 

Looking for your Guest Book and Calendar? Not to worry: They're still available, but the process 
has changed somewhat. Here's how to find them both using our updated Website Builder v6 log 
in process. 

1. Log in to your account. 

2. In the My Products page's Website Builder/InstantPage section, select the account you 
want to open and click Manage. 

Note: The Website Builder/InstantPage section only displays five accounts at a time, so 
you may need to click > to see the rest of your accounts. 

3. When the Site tab displays, click Design Your Pages near the center of the page. 
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4. In the top-right, click the Page menu and choose your calendar or guest book page. (Its 
name will vary depending on what you previously named it.) 

 

5. Double-click the calendar or guest book and make your changes. 

6. Follow the prompts to apply the changes and close the editing window. 

 

 

Adding or Removing Password Protection 
 

If you want to require your visitors to enter a user name and password before they enter your 
website, Website Builder lets you add password protection. 

You can password protect individual pages with different user names and passwords, use the 
same user name and password for one or more pages, or choose to disable previously set 
password protection. 

Note: You can password protect any page with the exception of .mobi pages, your Home page, 
and Flash® introductions. 

 

Adding Password Protection 
 

You can add password protection so visitors must enter user names and passwords to enter 
your website or view Web pages. 

 

To Add Password Protection 

 

1. Log in to your Website Builder account. 

2. If you are working in the Page Designer, click Exit Designer. 

3. Go to the Manage menu, and then select Password Protection. 

4. Select one of the following: 
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o Do not protect pages — Removes password protection if you added it. 
o Apply a different user name and password for each selected page — Requires 

visitors to enter specific login credentials for each page of your website. 
o Specify one user name and password for all protected pages — Requires visitors to 

enter login credentials once before entering your website. 

5. If applicable, select the pages to password protect, and then complete the User 
Name and Password fields. 

6. Click OK. Password protection is added. 

 

Removing Password Protection 
 

If you no longer want to require visitors to enter user names and passwords to enter your 
website, you can remove password protection. 

 

To Remove Password Protection 

 

1. Log in to your Website Builder account. 

2. If you are working in the Page Designer, click Exit Designer. 

3. Go to the Manage menu, and then select Password Protection. 

4. Select Do not protect pages. 

5. Click OK. Password protection is removed. 
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Adding Flash Files 
 

With Website Builder, you can add Flash® files to your website to visually enhance it. For 
example, it lets you display videos created using the Flash format. 

 

To Add Flash Files 

 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page you want to modify. 

5. Click Media, and then drag and drop the Flash icon over a Drop Zone. Drop Zones 
display on your Web pages when you hover over them. 

6. To select a file in your account, click Select a Flash File, and then select the file from the 
list. 

7. To upload a file, click the Browse button, locate and open the file, and then click Upload. 

8. To use a Flash file from another website, select Enter the URL to the Flash File, and then 
enter the URL where the file resides. 

9. Optional: In the Width and Height fields, enter the dimensions of the file. 

10. Optional: From the Background Color field, click the color picker, and then select a color 
for the background. 

11. Click OK. 
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Adding Flash Intros 
 

You can add a Flash® introduction to your Website Builder website by selecting one from our 
library, editing the properties of an existing Flash introduction, or uploading your own Flash 
introduction. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. If you are working in the Page Designer, click Exit Designer. 

4. From the Add-Ons menu, select Flash Intro. 

5. To upload your own flash file, select Upload custom Flash file, click Browse, select and 
open a SWF file, and then click Upload File. 

6. To select a flash file from our library, select Apply pre-built intro, and then do the 
following: 

o From the Category menu, select a category, and then select the template you want 
to use. 

o To preview the template, click either Update Preview or Preview in New Window. 

7. Click the Properties tab, and then do the following: 

o In the Page title field, enter the title your want to display for your intro page online. 
o From the Background Color section, click the color picker, select the background 

color you want to use, and then click OK. 
o In the Google® Meta tag name field, enter your Google Meta tag name. 
o In the Google® Meta tag content field, enter your Google Meta tag content. 
o In the Text line 1 field, enter the text you want to use on the Flash intro. For example, 

you might want to enter your website title. 
o In the Text line 2 field, enter additional text you want to use on the Flash intro. For 

example, you might want to enter your website tag line. 
o To change the default Enter Site text that displays below the Flash intro, in the Enter 

Site text field, enter the text you want to use. 
o To loop the Flash intro, select Continuously loop Flash intro until user clicks to enter 

site check box. 

8. Click the Music tab, and then do one of the following: 
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o To upload an audio file, click Browse, select and open the audio file you want to use, 
and then click Upload. 

o To use an audio file from our library, select Select audio on file, and then select a file 
from the list. You can listen to the audio file by clicking the Play icon. 

o To use an MP3 file from another website, select Enter the URL to the MP3 File, and 
then enter the URL for the file. 

9. Click Save. 

10. To turn off a flash intro, click the Flash Intro tab, select None selected, and then 
click Save. 

 

 

Uploading a Custom Flash Introduction 
 

With Website Builder, you can upload your own Flash® Introduction. A Flash introduction is a 
short animated introduction to your site. When the Flash introduction is complete, the visitor 
can click a link that will open your Home page. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. If you are working in the Page Designer, click Exit Designer. 

4. From the Add-Ons menu, select Flash Intro. 

5. Select Upload Custom Flash Intro. 

6. Click Browse to open a file dialog box. 

7. Select your .swf file and click Open. 

8. Click Upload File. 

9. Click Save Flash Intro. 

10. To view your Flash introduction on the Internet, publish your site, then view it online. 
Your new Flash introduction should display when you enter your URL in a browser. 
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Adding Audio 
 

Note: Only the desktop version of a Website Builder will support the audio player. 

Using Website Builder, you can add audio files in MP3 format to play music on your website. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page you want to modify. 

5. Click Media, and then drag and drop the Audio icon over a Drop Zone. Drop Zones 
display on your Web pages when you hover over them. 

6. From the Choose source menu, select one of the following sources, and then perform 
the appropriate steps: 

o Upload Audio — Upload an audio file from your computer: 
• From the Select and upload your audio section, click Browse. 
• Select the audio file you want to upload, and then click Open. To select 

multiple files, hold the Ctrl key while selecting files. 
• Click Upload. 

o Select audio on file — Select an audio file uploaded to your account: 
• From the Select audio menu, select the audio file you want to add. 
• To preview an audio file, click Play. 
• Go to the Settings (optional) section 
• To begin playing audio when visitors reach your Web page, select Autostart 

this file. 
• To automatically replay audio, select Loop this file. 
• From the Select Player section, select the type of audio player you want to 

use. 
o Enter the URL to the MP3 File — Link to a URL where your audio file exists: 

• In the Enter URL field, enter the URL where your file exists. 
• Go to the Settings (optional) section. 
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• To begin playing audio once visitors reach your Web page, select Autostart 
this file. 

• To automatically replay audio, select Loop this file. 
• From the Select Player section, select the type of audio player you want to 

use. 

7. Click OK. 

 

 

Adding Flickr 
 

Using Website Builder, you can add an app to display photo feeds from Flickr® directly on your 
website. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page you want to modify. 

5. Click Media, and then drag and drop the Flickr icon over a Drop Zone. Drop Zones 
display on your Web pages when you hover over them. 

6. From the Properties tab, in the Title field, enter a name to display with the Flickr app. 

7. From the Flickr feed section, select either Tags or RSS URL, and then enter a tag or feed 
URL to display the photos associated with it. 

8. From the Colors tab, select a font, size, and color for the heading and links. 

9. From the Preview tab, review your Flickr app to make sure it displays correctly. 

10. Click OK. 

To see your changes online, you must publish your website. 
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Adding Twitter 
 

Website Builder v6 features a Twitter® app that lets you display tweets from your Twitter 
account or users you specify. You can also display tweet replies and mentions, and include 
hashtags and text selections in search terms. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page you want to modify. 

5. Click Social, and then drag and drop the Twitter icon over a Drop Zone. Drop Zones 
display on your Web pages when you hover over them. 

6. In the Title section, enter a name you want to display with the Twitter app. 

7. To display tweets from your account, select My tweets, and then do the following: 

o Click Connect to Twitter. 
o Enter the user name and password for your Twitter account. 
o Click Authorize app. 
o To display tweets directed at you, select Include @ replies. 
o To display tweets forwarded to you, select Include retweets. 
o To display tweets from users you follow, select Include followed users' tweets. 

8. To display tweets from a specific user, select Search public tweets, and then do the 
following 

o In the Twitter usernames section, enter the names of the users whose tweets you 
want to display. 

o To display tweets directed at the users you entered, select Include @ replies. 
o To display tweets that include the names of users you entered, select Include 

mentions. 
o To display tweets associated with particular hashtags or topics, enter those terms in 

the #Hashtags field. 
o To display tweets associated with particular search terms, enter the search terms in 

the Search terms field. 
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9. Go to the Color tab, and then select a color for your heading, the characters in your 
tweets, the background behind tweets, and the links your tweets display. 

10. Go to the Preview tab, and then review your Twitter app to make sure it displays 
correctly. 

11. Click OK. 

 

 

Add YouTube 
 

YouTube no longer supports the software component used for Website Builder v6 and 
InstantPage. However, you can still display YouTube videos by adding HTML code to your 
Website Builder v6 pages. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Pages menu, select the page to which you want to add a video. 

5. Click the content block you want to edit, and at the block's bottom-left, click 
the HTML button. 

 

6. After the Edit HTML window opens, switch to a new tab or window in your web browser. 

7. Browse to the YouTube video you want to place on your page. 

8. Click the Share button below the video to display a field containing code. 

9. Click Embed and then Show More below the code field. 
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10. Use the Video size menu to choose a standard display size or Custom size, then select or 
deselect the choices listed below the menu. 

 

 Note: The code field's content changes based on your choices. 

11. Copy all content in the code field. 

 

12. Switch back to your Website Builder v6 page and replace the Edit HTML window's code 
by pasting in the copied YouTube code. 

13. Click OK to close the Edit HTML window. 

Note: To preview the video within your Website Builder v6 page, click the play arrow. To 
adjust the settings, click the < > button again. 

14. When you're ready, click Publish. 
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Adding RSS Feeds 
 

With Website Builder, you can display RSS feeds that let you subscribe to websites such as news 
sites and blogs, and then display their content on your own site. When the websites in your 
feeds update their content, visitors can see those updates. 

 Note: If you have an SSL certificate installed on your website, RSS feeds may not display. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page you want to modify. 

5. Click Social, and then drag and drop the RSS Feed icon over a Drop Zone. Drop Zones 
display on your Web pages when you hover over them. 

6. To add a new RSS feed, select Type or paste the RSS feed URL, enter the URL for the 
feed, and then enter a name for the feed in the Name of feed field. 

7. To add a popular RSS feed, select Select from popular RSS feeds, and then select a feed. 

8. From the Properties tab, complete the fields you want to specify: 

o From the Font menu, select a font for the text. 
o From the Size menu, select a font size for the the text. 
o From the Color section, select a color for the feed. 
o From the Settings section, select the maximum number of posts you want to display. 
o If you want links to open in new windows, select Open links in a new window. 

9. From the Preview tab, review your RSS feed to make sure it displays correctly. 

10. Click OK. 
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Adding Yelp 
 

Using Website Builder, you can add a Yelp® app to your Web pages that lets visitors view your 
Yelp ratings and read reviews about your business. 

To Add Yelp 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Current Page menu, select the page that you want to modify. 

5. Click Social, and then drag and drop the Yelp icon over a Drop Zone. Drop Zones display 
on your Web pages when you hover over them. 

6. If you do not know your Yelp ID, from the Find Yelp ID tab, enter you Business 
Address and Business Name, and then click Next. 

7. If you know your Yelp ID, click I know my Yelp ID, enter your Yelp ID, and then 
click Next. 

8. From the Search Results tab, select your business from the list, and then click Next. 

Note: If you do not see your business listed, you can add it from the Yelp website. 

9. Go to the App Settings tab, and then in the Title field, enter a title to display with your 
app. 

10. Select any of the following features you want to add to your app: 

o Profile Photo — Displays the Yelp profile photo of the business. 
o Yelp Rating — Displays the Yelp rating of the business. 
o Deals — Displays deals listed on Yelp for the business. 
o Snippet — Displays brief information about the business. 
o Reviews — Displays reviews listed on Yelp about the business. 
o Map — Displays a map of the business. 

11. Click Done. 

To see your changes online, you must publish your website. 
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Adding OpenTable 
 

You can add an OpenTable® app to your website that lets your website's visitors make 
reservations to your restaurant. Once reservations are made, the information is immediately 
submitted to your OpenTable account. 

1. Log in to your Website Builder account. 

2. Click Design Your Pages. 

3. If necessary, from the Current Page menu, select the page that you want to modify. 

4. Click Apps, and then drag and drop the OpenTable icon over a Drop Zone. Drop Zones 
display on your Web pages when you hover over them. 

5. In the OpenTable ID field, enter your ID number for your OpenTable account. 

6. In the Title field, enter the name that you want to display for your app. 

7. From the Size menu, select the size of your app. 

8. From the Default Reservation Date menu, select the date that displays by default when 
your website's visitors make reservations. 

9. From the Default Reservation Time menu, select the time that displays by default when 
your website's visitors make reservations. 

10. From the Customize tab, specify the style and color scheme of your app, and then 
click OK. 

Note: If you experience any issues connecting to OpenTable, please see OpenTable's 
support website. 

To see your changes online, you must publish your website. 
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Integrating Quick Shopping Cart 
 

With Website Builder, you can display products from your Quick Shopping Cart® account on 
your site. Visitors can then view and purchase your products. You can also display a navigation 
link to your online store. 

Note: You must publish your online store before adding a Quick Shopping Cart app to your 
website. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page you want to modify. 

5. Click Apps, and then drag and drop the Quick Shopping Cart icon over a Drop Zone. 
Drop Zones display on your Web pages when you hover over them. 

6. Go to the Select Products tab, and then do the following: 

o From the Select Quick Shopping Cart Account menu, select a Quick Shopping Cart 
account. 

o From the Categories section, select the categories and sub-categories associated 
with products you want to display. 

7. Go to the Settings tab, and then do the following: 

o From the Select display style section, select Thumbnails or Carousel. 
o From the Number of products to display section, select a number 

of Columns and Rows. 
o From the Select button style section, select a button style. 
o To display product categories, select Display Categories. 

8. From the Preview tab, confirm that your products display the way you want, and then 
click OK. 

 

To Create a Navigation Link to Quick Shopping Cart 

 

1. Log in to your account. 
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2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. If you are working in the Page Designer, click Exit Designer. 

4. From the Add-Ons menu, select Quick Shopping Cart. 

5. From the Choose Quick Shopping Cart Account list, select a Quick Shopping Cart 
account. 

6. In the Navigation button title to display on home page of website field, enter the text you 
want to display in the link to your online store. 

7. Click OK. 

 

 

Adding MapQuest 
 

With Website Builder you can add a MapQuest® app to your Web pages. Simply enter an 
address to let visitors view a map and get directions to that location. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Current Page menu, select the page you want to modify. 

5. Click Apps, and then drag and drop the MapQuest icon over a Drop Zone. Drop Zones 
display on your Web pages when you hover over them. 

6. From the Properties tab, in the Title field, enter a name to display with your map. 

7. In the Address field, enter an address to display on the map. For best results, enter a 
complete address including city, state and ZIP. 

8. To add another address, click Add New Address. 

9. To delete an address, click the X next to the address you want to remove. 

10. To see how the app looks to visitors, click the Preview tab. 

11. Click OK. 
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Adding PayPal 
 

With Website Builder, you can add a PayPal app to your Web pages that lets visitors send you 
funds from your site. It's a useful tool, for example, if your website promotes a non-profit 
organization the PayPal app would let visitors make donations. 

Note: You must have a PayPal Premier or Business Account to accept payments. If you don't 
have an account, visit PayPal to open one. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page you want to modify. 

5. Click Apps, and then drag and drop the PayPal icon over a Drop Zone. Drop Zones 
display on your Web pages when you hover over them. 

6. Select Buy Now or Donate. 

7. Click the layout you want to display. 

8. Complete the required fields. 

9. Click OK. 

To see your changes online, you must publish your website. 
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Add Google Analytics 
 

Website Builder version 6 allows you to add a Google® Analytics script to your site, which lets 
you monitor visits to your website. This service requires a Google Analytics account. 

1. Follow Google's instructions to create a Google Analytics account. 

2. Copy the Tracking ID that Google Analytics generates. 

3. Log in to your Website Builder account. 

4. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

5. Click Design Your Pages. 

6. Click Popular, then drag and drop the Script icon over a Drop Zone. (Drop Zones display 
on the Web page as you roll your cursor over them.) 

 

7. In the Edit Script text box, delete the default scripting. 

 

8. Paste in the Tracking ID script you copied from Google. 

9. Click OK to close the Edit Script box, and a small Script icon displays on the page. 

 

10. Click Publish to apply change to your site. 

 

Note: Once you complete these steps, you should see data in your Analytics account within 
24 hours. 
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Adding Apps from Google 
 

You can add these apps from Google® to your Web pages in Website Builder to increase the 
functionality of your website: 

o Google Adsense® — Lets you earn money by displaying ads on your website. You track 
earnings with reports from Google. First, you must set up an account. 

o Google Custom Search® — Lets visitors use Google to search the Web from your 
website. It also searches for content within your website. 

o Google Site Translator® — Lets visitors translate your website into a language they 
select. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Current Page menu, select the page you want to modify. 

5. Click Apps, and then drag and drop the Google Adsense icon over a Drop Zone. Drop 
Zones display on your Web pages when you hover over them. 

6. In the Publisher ID field, enter the publisher ID you received when you set up an account 
with Google AdSense. 

7. Select the ad orientation you want to use. 

8. Click OK. 

 
To Add Google Custom Search 
 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Current Page menu, select the page you want to modify. 
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5. Click Apps, and then drag and drop the Google Custom Search icon over a Drop Zone. 
Drop Zones display on your Web pages when you hover over them. 

6. In the Search engine name field, enter the name that will display for your site search app. 

7. In Style field, select the colors and layout for your site search app. To select your own 
colors, fonts and display options, click Customize. 

8. Select that you have read and agree to the Google Terms of Service, and then click OK. 

 

To Add Google Site Translator 
 

Note: Google Site Translator is only available with Deluxe or Premium Website Builder 
accounts. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page you want to modify. 

5. Click Apps, and then drag and drop the Google Site Translator icon over a Drop Zone. 
Drop Zones display on your Web pages when you hover over them. 

6. In the Customize section, from the Your Site's Language menu, select the language your 
website displays before translation. 

7. From Text Color field, select a color from the color picker or enter a color value, and 
then click Done. 

8. From the Background Color field, select a color from the color picker or enter a color 
value, and then click Done. 

9. To display the Google logo with the app, select Include logo. 

10. Click Get Widget. 

To see your changes online, you must publish your website. 
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Customizing Google Sitemap Settings 
  

Website Builder allows you to customize a sitemap of your website. Sitemaps created with 
Website Builder let Google know how often your site is updated, and how to look at your site. 
There are two sitemap settings you can customize: 

 

Frequency — Change Frequency tells Google how often you update a particular page. 
This is especially helpful if you update your Web page frequently. 

 

Priority — Google sitemaps allow you to prioritize your Web pages. You prioritize pages 
relative to their importance WITHIN your site. This does not affect your search engine 
rankings. It tells search engines that certain pages on your site are more important than 
others. For instance, you may want to call more attention to a home page, or a sales 
page. 0.0 is the lowest priority, 0.5 is the middle priority, and 1.0 is the highest priority. 
Assigning all of your pages a priority of 1.0 will not help your ranking. 

 

To Customize Google Sitemap Settings 

 

1. Log in to your Website Builder account. 

2. If you are working in the Page Designer, click Exit Designer. 

3. From the Manage menu, select Google Sitemap. 

4. Select a Change Frequency and Priority for the pages you want to customize. 

5. Click OK. 
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Adding Calendars and Event Calendars 
 

Website Builderv6 lets you add calendars to your Web pages for your visitors' convenience. You 
can also add event calendars, which lets your visitors view your upcoming or recurring events. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Current Page menu, select the page that you want to modify. 

5. Click Apps, and then drag and drop the Calendar icon over a Drop Zone. Drop Zones 
display on your Web pages when you hover over them. 

 
To Add an Event Calendar in Website Builder 
 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Current Page menu, select the page that you want to modify. 

5. Click Apps, and then drag and drop the Event Calendar icon over a Drop Zone. Drop 
Zones display on your Web pages when you hover over them. 

6. In the Calendar Name section, enter a name for your calendar. 

7. In the Calendar Size section, select either Full Size or Compact. 

8. In the Calendar Style section, select how you want your calendar to display. 

9. In the Display Calendar Title section, enter the title for your calendar that will display on 
your website. 

10. From the Display Month list, select the month that you want to display for your calendar. 

11. From the Display Year list, select the year that you want to display for your calendar, and 
then click Add Event. 
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12. From the Event Details window, complete the following steps: 

o In the What field, enter a title for the event. 
o In the Where field, enter a location for the event. 
o From the Start section, select a start date and time for the event. 
o From the End section, select an end date and time for the event. 
o To specify that the event will last the entire day, select All day. 
o In the Description field, enter the details of the event. 
o To tag an event for something such as an appointment, next to Event tag, click Add, 

enter a title, select a color, and then click OK. 
o To select an existing event tag, from the Select tag menu, select an event tag. 
o To delete an event tag, next to Event tag, click Delete. 
o To copy an event, next to Copy Event, click Copy. 
o Click OK. 

13. If you are finished adding events, click OK. 

14. To delete an event calendar, move your mouse over the Event Calendar, go to 
the gear icon, and then click Delete Block. 

To see your changes online, you must publish your website. 

 

 

Add Scrolling Marquees 
 

With Website Builder, you can add scrolling marquees to your Web pages. They display text 
that scrolls across the pages, such as welcome or promotional messages. Marquees are limited 
to 255 characters. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page you want to modify. 
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5. Click Apps, and then drag and drop the Scrolling Marquee icon over a Drop Zone. Drop 
Zones display on your Web pages when you hover over them. 

6. Do the following: 

o Marquee Text — Enter text for the marquee. 
o Text Style — Select the font the display text. 
o Font Size — Select a font size for the text. 
o Direction — Select a direction for the marquee to scroll. 
o Alignment — Select an alignment for the text. 
o Speed — Select the scroll speed for the marquee text. 

7. Click OK. 

8. To adjust the scrolling marquee's height and width, click the scrolling marquee, and 
then drag an edge to the appropriate position. 

 Note: The re-size feature doesn't display in Google Chrome. 

 

 

Adding Date and Time Stamps 
 

With Website Builder you can add a date and time stamp to your website that updates 
automatically for your visitors according to the dates and times on their computers. 

To Add Date and Time Stamps 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Current Page menu, select the page you want to modify. 

5. Click Apps, and then drag and drop the Date/Time Stamp icon over a Drop Zone. Drop 
Zones display on your Web pages when you hover over them. 
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6. From the Date format menu, select a format. 

7. From the Time format menu, select a format. 

8. Click OK. 

To see your changes online, you must publish your website. 

 

 

Adding Sitemaps 
 

You can help ensure that your Web pages are crawled by search engines by adding a sitemap. A 
sitemap informs search engines that individual pages on your website are new and updated, or 
available for crawling. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. Click Pages, and then select Add Sitemap. 

You must publish your website for your changes to take effect.  

 

 

Adding Hit Counters 
 

With Website Builder, you can add hit counters to your Web pages. For each time visitors reach 
a page, a hit displays on its counter. 

Note: Hit counters reset each time you publish your website. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 
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4. If necessary, from the Current Page menu, select the page you want to modify. 

5. Click Apps, and then drag and drop the Hit Counter icon over a Drop Zone. Drop Zones 
display on your Web pages when you hover over them. 

6. From the Select a hit counter style list, select a style. 

7. In the Enter a starting value field, enter a value. 

8. From the Add Zeroes menu, select the amount of digits you want to display. 

9. Click OK. 

 

 

Adding eBay 
 

With Website Builder you can add an app that lets you display products from an eBay® store. 
When visitors click those products, they're directed to the online store where they can buy 
them. 

 

To Add eBay 

 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Current Page menu, select the page you want to modify. 

5. Click Apps, and then drag and drop the eBay icon over a Drop Zone. Drop Zones display 
on your Web pages when you hover over them. 

6. Go to the Properties tab, and then in the Title field, enter the name you want to display 
on the eBay app when it opens. 

7. In the eBay store name field, enter the name of the eBay store whose products you want 
to display. 

8. To see how your products displays once it's live on the Internet, click the Preview tab. 
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Changing a Template 
 

Using Website Builder, you can easily change your website's template at any time. Changing 
your template lets you explore a variety of design and color combinations, which can completely 
change the look and feel of your website. 

You can change your template from the Website Builder home page when you first log in to 
your account, or from the Page Designer as you work on your site. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click the Templates tab. 

4. From the Preview menu, select Site. 

5. From the Sort menu, select one of the following: 

o Date — Displays recently created templates. 
o Name — Displays templates in alphabetical order. 
o Popularity — Displays the most popular templates. 

6. From the Template Gallery tab, click the template you want to use. 

7. Select a color scheme for your template, and then click Apply to My Site. 

8. Select Back up Website Builder site before applying new template, and then click OK. 

9. From the My Templates tab, review your selection, and then click Work On My Site. 

10. Design your Web pages the way you want them to display online. For more information, 
see Designing Pages. 

 

To Change Your Template from the Page Designer 
 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. Click Styles, and then select Launch Templates. 
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5. From the Preview menu, select Site. 

6. From the Sort menu, select one of the following: 

o Date — Displays recently created templates. 
o Name — Displays templates in alphabetical order. 
o Popularity — Displays the most popular templates. 

7. From the Template Gallery tab, click the template you want to use. 

8. Select a color scheme for your template, and then click Apply to My Site. 

9. Select Back up Website Builder site before applying new template, and then click OK. 

10. From the My Templates tab, review your selection, and then click Work On My Site. 

11. Design your Web pages the way you want them to display online. For more information, 
see Designing Pages. 

 

 

Enabling Social Media Sharing 
 

With Website Builder, visitors can share your site on social networks such as Facebook®, 
Twitter®, MySpace®, Delicious®, and StumbleUpon®. Visitors simply click buttons that 
prominently display icons of those social networks. Your site then displays on their profiles. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page you want to modify. 

5. Click the Social tab, and then drag and drop the Share icon over a Drop Zone. Drop 
Zones display on your Web pages when you hover over them. 

6. To select a size for the icons, from the Icon Size section, select Small or Large. 

7. Select the social media links that you want to add. 

8. Click OK. 
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Adding Facebook Social Plugins 
 

Website Builder lets you add Facebook® Social Plugins to content blocks in your Web pages for 
more visitor interaction. At the Facebook Developers website, you can customize your own 
Social Plugins, such as a Like button or an Activity Feed, which shows your Website Builder 
visitors what their Facebook friends are doing. 

You can add Social Plugins by pasting the iframe or XFBML code from the Facebook 
Developers website into the HTML field of the content block where you want to display the 
Social Plugin. 

1. Go to the Facebook Developers Social Plugins Web page, 
https://developers.facebook.com/docs/plugins. 

2. From the Social Plugins list, click the Social Plugin you want to display. 

3. Enter values in the fields, and then click Get Code. 

4. In a new browser window, log in to your Website Builder account. 

5. From the Design drop-down menu, click Launch Page Designer. Your website displays in 
the page designer. 

6. From the Page drop-down menu, select the page where you want to display the Social 
Plugin. 

7. Click the block where you want to display the Social Plugin. Blocks are outlined in blue. 

8. Click HTML. 

9. Back on the Facebook Developers Social Plugins Web page, from the HTML5, XFBML, 
IFRAME, or URL tab (depending on your needs), copy each section of code and paste it 
in your Website Builder Edit HTML window where directed. 

 Note: Some options have only one code section to copy and paste. 

10. Click OK. You'll need to re-publish your website to display the Social Plugin on your Web 
page. 
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Add scripts and HTML 
 

You can add JavaScript and HTML code to your website to display custom page elements, such 
as third-party apps. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page you want to modify. 

5. Click Popular, and then drag and drop the Script icon over a Drop Zone. Drop Zones 
display on your Web pages when you hover over them. 

6. In the Enter JavaScript text box, delete the default scripting, and then enter your script. 

7. Click OK. 

8. Click Publish in the upper right. 

For information about inserting JavaScript in Web page headers, see Setting Page Properties. 

Note: JavaScript does not execute in the Page Designer. You must use Preview mode to 
execute it. 

 

To Add HTML 

 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. If necessary, from the Page menu, select the page that you want to modify. 

5. Click the content block you want to edit, and then click the  icon. 
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6. Enter the HTML code you want to use. 

7. To ensure your HTML is formatted correctly, click Verify and Update HTML, and then 
click OK. 

8. Click Publish in the upper right. 

 

 

Adding Custom CSS 
 

If you have experience editing cascading style sheets, you can add custom CSS to your website 
to change the design conditions of your template. For example, if the template you selected 
only lets you add template images in a specific area, you can override that setting through 
custom CSS. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. Click Design Your Pages. 

4. Click Styles, and then select Custom CSS. 

5. From the CSS File list, select one of the following: 

o Theme — CSS for your website's template. 
o Colors — CSS for your website's color scheme. 

6. From the Read only view of CSS file section, highlight and copy the text you want to edit, 
and then paste it in the Edit view of CSS file section. 

7. From the Edit view of CSS file section, make your edits to the text. 

8. To apply your custom CSS, select Use Modified CSS, and then click Apply. 

9. Click OK. 
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Editing Your Contact Information 
 

You initially enter your contact information the first time you launch Website Builder. You can 
edit your contact information at any time. When you edit your email address, you do not need to 
republish your website. Website Builder updates the email address for you. However, when you 
edit your company or individual name, you must republish before the changes take effect. 

To Edit Your Contact Information 

1. Log in to your Website Builder account. 

2. If you are working in the Page Designer, click Exit Designer. 

3. From the Settings menu, select Site. 

4. In the Company or individual name field, edit the name. 

5. In the Email Address field, edit your email address. 

6. Click OK. 

 

 

Viewing Your Account's IP Address 
 

If your website isn't displaying live on the Internet, you might need to modify your Website 
Builder account's IP address. You need your IP address to edit your domain name's A record 
and point to your website.  

Note: You must publish your website at least once for your IP address to display. 

To View Your Website Builder Account's IP Address 

1. Log in to your account. 

2. Click Website Builder. 

3. Next to the Website Builder account you want to use, click Manage. 

Your IP address displays in the IP Address field. 
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Change my domain 
 

With Website Builder, you can change the domain name associated with your account. 

Note: You cannot change the domain name for a free Website Builder account, nor a 
domain where a SSL (Secure Sockets Layer) certificate has been applied. Log in to your 
account. 

1. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

2. Hover over Settings. 

3. Click Site, and then select one of the following: 

o Select an available domain from your account — Select a domain in your account 
from the Select Available Domain list. 

o Enter a domain not registered in this account — Enter a domain that isn't in your 
account, such as one from another registrar. 

o Enter a subdomain for a domain in this account — Create a subdomain for your 
website, such as site.coolexample.com 

4. Click OK. 

 

 

Aliasing Domains 
 

You can assign multiple domains to your Website Builder site. The domains display the same 
site as the primary domain associated to the Website Builder account. 

Assigning multiple domains to a single Website Builder site is called domain aliasing. Aliasing is 
preferred to forwarding domains to your site as forwarded domains are less searchable than an 
aliased domain. 

You can only alias domains that are available within your customer account. Please allow up to 
48 hours for the aliased domain to display your site. 

1. Log in to your account. 

2. Click WEB_BUILDER/INSTANTPAGE. 
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3. Next to the WEB_BUILDER/INSTANTPAGE account you want to edit, click Manage. 

4. From the Tools section, select Hosting Settings. 

5. From the Options & Settings section, select Aliased Domains. 

6. Click Add Aliases. 

7. Follow the onscreen instructions to add or remove aliased domains. 

8. When finished, click Continue. 

 

 

Add an SSL Certificate 
 

You can add an SSL certificate in your Website Builder site to provide visitors with a secure 
connection when they submit information, such as payment or contact details. After your SSL is 
issued, you can select which pages you want to secure. 

You can also display a Site Seal on your website that lets your visitors know the information they 
send through your site is secure. 

Note: Pages using the SSL certificate will use HTTPS instead of HTTP in your Web browser's 
address bar. HTTPS is the secured version of the HTTP protocol. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. If you are working in the Page Designer, click Exit Designer. 

4. From the Home screen, in the SSL Certificate section, click Upgrade. 

5. Follow the purchase process and complete any remaining instructions to request your 
SSL. The length of time it takes to approve your SSL depends in the type of certificate 
you purchased. 

6. If your SSL request is approved, you will receive an email letting you know it is installed. 

7. Log back in to your Website Builder account. 

8. From the Manage menu, click Organize Site. 

9. Click the thumbnail of the page you want to edit. 
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10. Select Make this page Secure. 

11. Repeat these steps for any other pages in your website. 

12. From the Design menu, click Launch Page Designer. 

13. If necessary, from the Current Page menu, select the page that you want to modify. 

14. Click Popular, and then drag and drop the Site Seal icon over a Drop Zone. Drop Zones 
display on your Web pages when you hover over them. 

 

 

Add an SSL Site Seal to my site 
 

If you've bought an SSL certificate, you can display a site seal on your Web pages. A site seal 
lets your visitors know that information they send through your website, such as payment or 
contact information, is secure. 

There are two ways you can add a site seal to your Web pages: You can insert a site seal using a 
menu in the Page Designer. Website Builder automatically detects an SSL you associate with 
your domain. 

Or add a site seal by retrieving the HTML from the SSL in your account, and then pasting it into 
content blocks where you want it to display. You may find this method useful if you're confident 
that you can edit the HTML to adjust how your site seal displays. 

 

Inserting Site Seal With Page Designer 
 

Website Builder automatically detects an SSL you purchased, letting you add it in the Page 
Designer. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. From the Design drop-down menu, click Launch Page Designer. Your website displays in 
the page designer. 
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4. From the Page drop-down menu, select the page where you want to display the site seal. 

5. Click Popular, and then drag and drop the Site Seal icon over a Drop Zone. Drop Zones 
display on your Web pages when you hover over them. 

6. Re-publish your website to display the site seal on your Web page. 

 

Adding Site Seal HTML to Content Blocks 
 

Retrieve and copy the HTML for your site seal so you can paste it into content blocks where you 
want to display it. 

1. Log in to your Account Manager. 

2. Click SSL Certificates. 

3. Go to the certificate you want to display on your website, and then click Manage. 

4. Click Site Seal. 

5. Select your color, and then click Save. 

6. In the HTML field, copy the HTML for your site seal. You can also edit the HTML if you 
paste it into a basic word-processing application, such as Microsoft® WordPad®. 

Note: Do not use Microsoft Word®, as you will carry over unseen formatting that can 
cause your Web page to display incorrectly. 

7. Log in to your account. 

8. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

9. From the Design drop-down menu, click Launch Page Designer. Your website displays in 
the page designer. 

10. From the Page drop-down menu, select the page where you want to display the Site 
Seal. 

11. Click the block where you want to display the site seal. Blocks are outlined in blue. 

12. Click the HTML icon. 

13. Paste the code in the Edit HTML window, and then click OK. 

14. Re-publish your website to display the site seal on your Web page. 
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Viewing File Size and Loading Information in Website Builder 
 

With Website Builder, you can view information about the individual files used on your website, 
including the image files and HTML files. The size of your pages and the files that make up your 
website can affect the speed at which the pages of your Web site load in a browser. Use the file 
size information, as well as the estimated load times for the different connection speeds, to 
determine if you need to reduce your file sizes. 

To View File Size and Loading Information 

1. Log in to your Website Builder account. 

2. If you are working in the Page Designer, click Exit Designer. 

3. From the Manage menu, select File Size/Loading Info. 

4. You can view the following: 

o File Size Indicator (colored icon) column - The color of the icon indicates if the file 
size is acceptable, approaching the recommended maximum size, or too large. The 
color legend is located beneath the table. 

o Page/File Name - Displays the name of the file or page. 
o Size column - Displays the size of the file. 
o 56K column - Displays the number of seconds it takes a browser to load the file 

using a 56K speed modem. 
o 128K column - Displays the number of seconds it takes a browser to load the file 

using a 128K speed modem. 

5. To expand the detail for a Web page, click the + sign next to the name of the page. 

6. To edit a page, click the Edit button. 

7. To delete a page or image, click the Delete button, and then click OK to confirm the 
deletion. 

Note: You cannot delete the Home page. 

 

 



Website Builder 6 Help Guide                                                                                                            143 
 

Starting Your Website Over 
 

If you are using Website Builder to build a website, you can use the Start Over option to remove 
all your Web pages and begin creating your website from scratch. We recommend that you 
backup your website before restarting. 

 

To Start Your Website Over 

 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. If you are working in the Page Designer, click Exit Designer. 

4. From the Tools section, click Start Over. 

 Note: You can also go to the Manage menu, and then select Start Over. 

5. To create a backup of your website before restarting, select Back up website before 
starting over. 

6. Select Yes, I want to remove all site content and start over. 

7. Click Start Over. 

 

 

Which version of Website Builder do I have? 
 

We support two versions of Website Builder: version 6 and version 7. Here's how to see which 
version you have. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. The Website Builder name appears in the upper left of your screen. Version 6 displays a 
number; the current version simply shows Website Builder without a number. 
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Disabling Adblock Plus 
 

If you're using the Adblock Plus™ extension, you must disable it to open Website Builder. 

1. In your browser's toolbar, click the Adblock Plus icon to expand the menu. 

2. Select disableadblockplus.org. 

Note: The menu also gives you the option to disable Adblock Plus on just the page you're 
on. So you can add an exception rule for your Website Builder login page. 

 

 

Fix Microsoft Word Formatting Problems 
 

Copying and pasting content from a Microsoft Word document into Website Builder v6 may 
cause the content (HTML or just text) to display incorrectly. Here's how to avoid the problem — 
and fix it if a web page already contains improper formatting. 

1. Copy the content from your Microsoft Word document. 

2. Log in to your account. 

3. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

4. Click Design Your Pages. 

5. If necessary, from the Page menu, select the page you want to modify. 

6. Click the block where you want to paste Microsoft Word content. 

7. Position your cursor where you want to place content. 
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8. If necessary, click More. 

9. Go to the Paste menu, and then select one of the following: 

o Paste from MS Word — Pastes content while preserving formatting, if possible. 
o Paste from MS Word, clear font — Pastes content while clearing the font you 

selected in Word. 

10. Enter your content in the content box, and then click Paste. 

 

 

Why aren't my fonts displaying correctly? 
 

Sometimes when visitors view your website, the fonts you use don't display correctly to them. 
Website Builder offers great font choices, so why do some visitors say your text displays in plain 
characters? 

It's because the font in question — called a system font — isn't installed on the device they 
used to view your website. 

While there's no recognized standard, system fonts are the most common. Examples include 
Arial, Helvetica, or Times New Roman. When you select Times New Roman for your text, it's 
safe to assume it displays correctly for everyone who visits your website. That's because it's 
also safe to assume Times New Roman is installed on pretty much any device a visitor would 
use. 

Not all devices share some of the less-common system fonts, such as Monotype Corsiva. When 
a someone visits your website using a device without Website Builder's system fonts, that text 
display as plain characters. 

However, Website Builder also has dynamic fonts, such as SeaSide Resort, that always display 
correctly for everyone. 
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Everyone browsing the Internet may not have Seaside Resort installed on their devices. When 
someone downloads a Web page that displays this font, Seaside Resort temporarily downloads, 
too. It's not saved permanently, just to their browser's cache, just long enough for them to view 
your Web page. 

Website Builder displays these dynamic fonts: 

o Airstream 
o Anagram 
o Boston Traffic 
o Comic Zine 
o EastMarket 
o Helsinki 
o JungleFever 
o Know Your Product 
o Learning Curve Pro 
o Metro 
o Plug-NickelBlack 
o QuigleyWiggly 
o SeasideResort 
o Shangri La 
o SouciSans 
o Umbrage 
o Veggieburger 
o WoodenNickelBlack 
o Xenophone 
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Why Do I Get An Error Message When Importing? 
 

When Website Builder v6 imports your InstantPage® website, an error message displays when 
any portion of your InstantPage website doesn't completely transfer. If the error message 
displays, don't worry. 

Click Retry Import to restart the import process. You can also click Go To My Account to launch 
Website Builder from your account and restart the import process. Some reasons why the error 
message displays include: 

o Incomplete download of images 
o Incomplete transfer of files 
o Incomplete transfer of content 
o Database save errors 

When Website Builder completely transfers your InstantPage website, the Getting Started page 
displays. To complete the import, click Get Started. 

Note: The import process must restart if you close the Getting Started page before you 
click Get Started. 

 

 

Linking my website pages to my Facebook page no longer 
supported 
 

You can no longer link Website Builder v6 pages to Facebook or update those pages on 
Facebook. 

Note: You should log in to Facebook and remove your Website Builder v6-generated 
pages there as well. 
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Why am I having trouble streaming video using Firefox? 
 

If you are experiencing difficulty viewing videos uploaded to your website, you may need to 
install the Windows Media Player® add-on from Mozilla®. 

You can download and install the Windows Media Player add-on by visiting Mozilla's Firefox 
add-on page. You can also visit https://addons.mozilla.org and search for the Windows Media 
Player plug-in. 

 

 

Removing the "Powered By Website Builder" Banner 
 

Note: This article is for Website Builder version 6. Your version displays at the top of the screen 
when you log in to your Website Builder account.  

You can hide the "Powered By Website Builder" banner from the bottom of your Website 
Builder website. When you hide the banner, it is removed from your published website. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. From the Settings menu, click Configuration. 

4. Select the option to Hide banner, and then click OK. 

Click Publish to publish your Website Builder website with the banner removed. 
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Why can't I access Website Builder? 
 

You may not be able to access the Website Builder application because your security settings 
are set to High. To access the application, you can either change the security level to Medium or 
add the application's URL to your Trusted Sites list. 

 

To Add Website Builder to Your Trusted Sites 
 

1. In Internet Explorer, from the Tools menu, click Internet Options. 

2. Click Security. 

3. Click Trusted Sites. 

4. In the Security level for this zone box, check your security level. You may need to do one 
of the following: 

o If it is set to High, use the slider to change it to a Medium or lower security level. 
o If it is set to Custom, click Default Level, and then use the slider to change it to 

a Medium or lower security level. 

5. Click the Sites button. 

6. Clear the Require server verification check box. 

7. In the Add this website to the zone field, type http://app.websitetonight.com. 

8. Click OK. 

9. On the Internet Options window, click OK. 
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What is a trusted site in Internet Explorer? 
 

A trusted site is a website that you trust not to damage your computer. 

If you set the security level of your Internet Explorer® browser to High, so that you do not 
access websites that might damage your computer, you may be unable to access a specific 
website that you trust. To access the website, you can add the URL of the website to your 
Trusted Sites list or change your security level to Medium or lower. When using a high security 
level, you need to add the Web application URLs to your Trusted Sites list. 

Note: If you are running Windows Vista, you must add the site with both "http" and "https." 
Also, trusted sites may open in a new browser window. 

 

To Add a Trusted Site in Internet Explorer 

 

1. From the Internet Explorer Tools menu, click Internet Options. 

2. Click Security. 

3. Click Trusted Sites. 

4. In the Security level for this zone box, check your security level. You may need to do one 
of the following: 

o If it is set to High, use the slider to change it to a Medium or lower security level. 
o If it is set to Custom, click Default Level, and then use the slider to change it to 

a Medium or lower security level. 

Note: If you are running Windows Vista, verify that Enable Protected Mode is NOT 
selected. 

5. Click the Sites button. 

6. In the Add this website to the zone field, type the URL for the trusted website. 

7. De-select Require server verification for all sites in this zone. 

8. Click Close. 

9. On the Internet Options window, click OK. 
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Note: Mozilla Firefox® does not specifically offer a trusted sites setting. However, you can 
set allowed sites for the limited purpose of installing cookies and add-ons. From 
the Tools menu, select Options and go to the Security tab. 

 

 

Change Email Address Used 
 

The Website Builder contact email address is used for any forms included on your website. 
Once a user submits a form, the information is sent to the contact email address you specified 
when you set up your Website Builder account. You can change this email address at any time. 

Note: A valid email address must be entered in this field. 

1. Log in to your account. 

2. In your Products list click Website Builder, and then click Manage next to the account 
you want to use. 

3. If you are working in the Page Designer, click Exit Designer. 

4. From the Settings menu, select Site. 

5. In the Email Address field, enter the email address you want to use to receive your form 
submissions. 

Note: The contact form cannot send to Live™, Gmail™, or Hotmail® addresses. You must 
use an email address associated with your domain. 

6. Click OK. 
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How to cancel your account 
 

Canceling your Website Builder v6 account deletes all of your website's files stored on our 
servers. Be sure you have copies of any files you want to keep before canceling your account. 

1. Log in to your account. 

2. Click Website Builder. 

3. From the Website Builder/InstantPage® pod, click Options for the account you want to 
cancel. 

4. From the Overview tab, click Cancel this account. 

5. Click Cancel Account. 

Note: It can take up to 24 hours for the domain name to be available for use again after 
you cancel your Website Builder account. 
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